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1 Welcome to COPA-DATA help

ZENON VIDEO-TUTORIALS

You can find practical examples for project configuration with zenon in our YouTube channel
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an
initial insight into working with different zenon modules. All tutorials are available in English.

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com.

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can
contact via email at support@copadata.com.

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com.

2 WPF element

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed.

Note: In the zenon Editor, the standard tooltip for the WPF element is not displayed if a .wpf file is
linked. Furthermore, in zenon Runtime, the zenon tooltip for WPF elements is not supported.

¥ |nformation

All brand and product names in this documentation are trademarks or
registered trademarks of the respective title holder.
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3 Basics

XAML

XAML stands for Extensible Application Markup Language. The XML-based descriptive text developed
by Microsoft defines graphic elements, animations, transformations, displays of color gradients etc. in
Silverlight and WPF user interfaces. The use of XAML makes it possible to strictly separate design and
programming. The designer prepares, for example, the graphical user interface and creates basic
animations that are then used by the developers/project planners who create the application logic.

WPF

WPF stands for Windows Presentation Foundation and describes a graphics framework that is part of the
Windows .NET framework:

»  WPF provides a comprehensive model for the programmer.

»  XAML describes, based on XML, the interface hierarchy as a markup language. Depending on
the construction of the XAML file, there is the possibility to link properties, events and
transformations of WPF elements with variables and functions of
CD_PRODUCTNAME<.

» The framework unites the different areas of presentation such as user interface, drawing,
graphics, audio, video, documents and typography.

For execution in zenon, Microsoft NET framework version 3.5 or higher is required.
¥ Information

Transparency

In order for WPF controls in which a transparent background has been defined
to also be displayed as transparent, the following must be the case on the
computer for both Editor and Runtime:

» The operating system must be at least Windows 8.1

» The .NET framework version 4.6 or higher must be installed

WPFs are not shown as transparent in Windows 7 or 8. Instead, the transparent
areas are filled with the background color set on the zenon screen.
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3.1 WPF in process visualization

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements
can be adapted graphically regardless of the project planning. For example, laborious illustrations are
first created by designers and then imported into zenon as an XAML file and linked to the desired logic.
There are many possibilities for using this, for example:

DYNAMIC ELEMENTS IN ANALOG-LOOK

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This
makes it possible to use complex, elaborately illustrated elements in process visualization. Reflections,
shading, 3D effects etc. are supported as graphics. The elements that are adapted to the respective
industry environment make intuitive operation possible, along the lines of the operating elements of the
machine.

INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION

The integration of XAML-based display elements improves the graphics of projects and makes it very
easy to display processes clearly. Elements optimized for usability make operation easier. A clear display
of data makes it easier to receive complex content. The flexible options for adapting individual elements
makes it easier to use for the operator. It is therefore possible for the project planners to determine
display values, scales and units on their own.

CLEAR PRESENTATION OF DATA AND SUMMARIES

Grouped display elements make it possible to clearly display the most important process data, so that
the equipment operator is always informed of the current process workflow. Graphical evaluations,
display values and sliders can be grouped into an element and make quick and uncomplicated control
possible.
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INDUSTRY-SPECIFIC DISPLAYS

o -

Elements such as thermometers, scales or bar graphs are part of the basic elements of process
visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment
operators can find the established and usual elements that they already know from the machines in
process visualization at the terminal.

ADAPTATION TO CORPORATE DESIGN

llustrations can be adapted to the respective style requirements of the company, in order to achieve a
consistent appearance through to the individual process screen. For example, the standard operation
elements from zenon can be used, which can then be adapted to color worlds, house fonts and
illustration styles of the corporate design.

3.2 Referenced assemblies

It is not just standard objects (rectangles, graphics, etc.) or effects (color gradients, animations, etc.) that
can be displayed using the WPF elements, but also customized user controls (with logic in the code
behind), which are referenced as assemblies.

For example, a user control that looks like a tacho and provides special properties and optical effects
can be created, such as a Value property, which causes the pointer of the tacho to move and/or the
corresponding value to be displayed in a label.

Procedure:
» Draw the appearance of the user controls with standard objects that are offered by WPF.
» Program the properties and interactions.
» Compile the complete package.

The result is available as a .NET assembly.
This assembly can be used for WPF projects. To do this, it must be referenced (linked) in the WPF editor

(for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file selection
dialog:

v @ DemoApplication

B Add Project Reference... ¥
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From this point in time, the WPF user controls of the assembly in the tool box can be selected under
Custom user controls and used in the WPF project.
Read more about this in the Guidelines for developers (on page 24).

USED REFERENCED ASSEMBLIES IN ZENON

To use an assembly in zenon, this must be provided as a file.
Collective files in .cdwpf format manage the assemblies independently. No further configuration is
necessary. Assemblies must be added to the Files folder for .xaml files:

» Click on Files on the project tree.

» Select Others

»  Select Add file... in the context menu
The file selection dialog is opened.

» Insert the desired assembly

When displaying a WPF file in the WPF element (Editor and Runtime), the assemblies from this folder are
loaded. It is thus also ensured that that when the Runtime files are transferred using Remote Transport,
all referenced assemblies are present on the target computer.

A collective file (.cdwpf) can exist alongside an XAML file with the same name. All assemblies (*.dll) from
all collective files and the Other folder are copied to the work folder. Only the highest file version is used
if there are several assemblies with the same name.

9129



® Hint

DLLs that are part of a WPF element can also be replaced during ongoing
operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:
» Close all zenon screens in which the WPF element is used.
» Close all symbols that use a desired WPF element.

» In Explorer, replace the DLL in the \wpfache folder of the Editor files.
You can find this folder in the SQL directory under
.\PROJECT-GUID\FILES\zenon\custom\wpfcache

As an alternative to replacement using Explorer, you can also replace the file in
the zenon Editor directly. To do this, carry out the following steps:

» Inthe Visual Studio project settings, increase the file version of the DLL.
» Create the new DLL.

» Close all zenon screens in which the WPF element is used.

» Close all symbols that use a desired WPF element.

» Inthe zenon Editor, delete the DLL from the \Files\Other folder and add the
file with the higher version number.

MULTI-PROJECT ADMINISTRATION

With multi-project administration, the same assembly must be used in all projects. If an assembly is
replaced by another version in a project, it must also be replaced in all other projects that are loaded
in the Editor or in Runtime.

3.3 Workflows

The WPF/XAML technology makes new workflows in process visualization possible. The separation of
design and functionality ensures a clear distinction of roles between the project engineer and designers;
design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified
by the project engineer.

The following people are involved in the workflow to create WPF elements in zenon:
» Designer
» illustrates elements
» takes care of the graphics for MS Expression Design

» MS Expression Blend operator
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P Animates elements

» Creates variables for the animation of WPF elements in zenon, which project engineer can
access

» Project engineer
» Integrates elements into zenon:
»  stores logic and functionality
We make a distinction:
»  Workflow with Microsoft Expression Blend (on page 11)
»  Workflow with Adobe lllustrator (on page 11)

3.3.1 Workflow with Microsoft Expression Blend

When using Microsoft Expression Blend, a WPF element is created in four stages:

1. lllustration of elements in MS Expression Blend (on page 12)
2. Open element in MS Expression Design and export as WPF
3. Animation in MS Expression Blend (on page 12)

4. Integration into zenon (on page 115)

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create
button as XAML file with Microsoft Expression Blend (on page 12) chapter.

3.3.2 Workflow with Adobe Illustrator

Based on traditional design processes with Adobe Illustrator the following workflow is available:

LN

llustration of elements in Adobe Illustrator (on page 16)
Import of .ai files and preparation in MS Expression Design (on page 18)
WPF export from MS Expression Design (on page 18)

Animation in MS Expression Blend (on page 20)

v W

Integration into zenon (on page 111)

You can find an example for creation in the Workflow with Adobe lllustrator (on page 16) chapter.
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4 Guidelines for designers

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe
llustrator. The tutorials on Creating a button element (on page 12) and a bar graph element (on page
16) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few
steps.

The following tools were used for this:

P Adobe lllustrator CS3 (Al
»  Microsoft Expression Design 4 (ED)
»  Microsoft Expression Blend 4 (EB)
»

Zenon
¥ Information

If referenced objects (assemblies) are used in WPF, note the instructions in the
Referenced objects (on page 8) chapter.

4.1 Workflow with Microsoft Expression Blend
With Microsoft Expression Blend, a WPF element:

» isillustrated

» is converted into WPF format using MS Expression Design

» animated
The following example shows the illustration and conversion of a button element into an XAML file.

Note: A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website.
4.1.1 Create button as an XAML file with Microsoft Expression Blend

CREATE BUTTON

1. Start Expression Blend
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2.

select the New Project option

r

Projects

ﬁ New Project...
B Open Project...

VI Run at startup Close

.

Select WPF as project type

give it a path and name of your choice (MyBlendProject, for example)

[PF Application

ff§ wer control Library

/PF Databound Application

A project for creating custom controls that can be reused across
other WPF applications.

Mame endProject
Location ‘\ElendProject Browse...
Language Visual C#

Version

Cancel

The Language and Version settings can be ignored, because no functionality is to be
programmed.

After the dialog has been confirmed with OK, Microsoft Blend creates a new project with the

chosen settings. Expression Blend adds an empty XAML file which already contains a class
reference.

Delete the CS file that belongs to the XAML file using the context menu.
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10.
1.

Rename the XAML file MainControl.xaml to MyButton.xaml.

The development size of the file is set at 640 x 480 pixels as standard and must still be
changed:

a) switch to XAML view

b) correct the size to 100 x 100 pixels

c) Delete the class reference x:Class="MyBlendProject. MyButton"

MyButton.xaml =
1 <UserControl
2 wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”
3 xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
4 xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
5 xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
6 mc:Ignorable="d"
7 wiName="UserControl” )
3 d:DesignwWidth="108" d:DesignHeight="J£!*U

18 <@Grid x:Name="LayocutRoot" />

12 < /UserControl:

switch to Design view

add a button via the toolbar

define the properties
> Width: 50
» Height: 50
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»  Margins: 25

Width 50
Height 50

Row 0 RowSpan 1

Column 0 ColumnSpan

Zindex 0
HorizontalAlignment  |[= =
VerticalAlignment 1

[
Margin + 2
+

The button is therefore at the center of the control.

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button
is displayed in a size of 50 x 50 pixels.

MAKE BUTTON SCALABLE

If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels.
Because the button can be implemented as a scalable button, switch to Expression Blend again:

1. Select the button in the tree view.
select the Group Into->Viewbox button in the context menu

the button is inserted into a Viewbox

oW

Define the properties of the viewbox
»  Width: Auto
» Height: Auto
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5. save the file

Cut

Copy
Paste
Delete
Rename

A Siz
Grid ctri+G
StackPanel
PFin Active Container DockPanel
SIEEE ZTE I Data bind Content to Data... Canvas
Edit Text ScrollViewer
Border
WrapPanel
UniformGrid

e e ’

Edit Additional Templates 3

UserControl Make Into Control...
Make Into UserControl...

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE
window size is changed. This file will now also automatically adapt to changes in the size of the
WPF element in zenon.

CHANGE NAME

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF
elements are not named in Expression Blend as standard, and are labeled with square brackets and
their type. zenon content is assigned to WPF content via the name of the WPF elements:

» intree view, change the name
» of the button on MyButton

» of the ViewBox to MyViewBox

This button can now be integrated in zenon (on page 115) as an XAML file.

4.2 Workflow with Adobe lllustrator

When Adobe lllustrator is used, a WPF element;
P isillustrated in Adobe lllustrator
» is converted into a WPF in MS Expression Design

» is animated in MS Expression Blend

The following example shows the illustration and conversion of a bar graph element into an XAML file.

4.2.1 Bar graph illustration

A bar graph is created in Adobe lllustrator.
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1. Al: Starting element for bar graph

lllustrated in Adobe Illustrator CS3.

2. Al: Path view of bar graph in Adobe lllustrator

»  All effects must be converted (Object -> Convert appearance)
» Alllines are transformed into paths (Object -> Path -> Contour line)

» Do not use filters such as shading, blurring etc.

NOTES ON COMPATIBILITY

llustrations that were created with Adobe lllustrator are in principle suitable for WPF export. However,
not all lllustrator effects can become corresponding effects in Expression Design/Blend. Note:

Clipping masks Clipping masks created in Adobe lllustrator are not correctly
interpreted by Expression Design. These are usually shown in
Blend as areas of black color.

We recommend creating illustrations without clipping masks.

Filters and effects Not all Adobe lllustrator filters are transferred into Expression
Design accordingly:  Thus blurring filters, shading filters and
corner effects from lllustrator do not work in Expression Design.

Solution:

»  Most effects can be converted so that they can be read
correctly by Expression Design using the Object ->
Convert appearance command in Adobe lllustrator.

» Corner effects from Adobe lllustrator are correctly
interpreted by MS Design if they are converted to Al in
paths.

Text fields To be able to link text fields with code, these must be created
separately in Expression Blend. "Labels" are required for dynamic
texts; simple "text fields" are sufficient for static information.
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There is no possibility to create text labels in MS Design. These
must be directly created in MS Blend.

Transparencies and group There can be difficulties in Adobe lllustrator with the correct
transparencies interpretation of transparency settings, in particular from group
transparency settings.

However MS Expression Blend and MS Expression Design do
offer the possibility to create new transparency settings.

Multiply levels These level settings in Adobe lllustrator are not always correctly
displayed by MS Expression Blend.

However, there is the possibility to "Multiply levels" directly in
Expression Design.

Indicating instruments and To prepare the graphics optimally for animation, the indicator
standard positions and slider must always be set to the starting position, usually 0 or
12:00 o'clock.

Thus the position parameters for rotations etc. are also correct in
Blend and an animation can be implemented without conversion
of position data.

4.2.2 WPF export

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft
Expression Design for this export, because it provides good results and most lllustrator effects are
correctly interpreted.

Note: There is a free plug-in for the direct export of WPF files from Adobe lllustrator available on the
internet. This plug-in provides a quick, uncomplicated way of exporting from lllustrator, however it is less
suited to the current application because it lead to graphical losses. Even color deviations from the
original document are possible.

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the
process.

Attention: Some common lllustrator effects cannot be displayed by Expression Design correctly
however (see lllustration (on page 16) chapter).

We export the pre-created bar graph element in 5 stages:

1. ED:Import
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» Import the prepared lllustrator file (on page 16) in Microsoft Expression Design via File ->
Import

ED: Optimization

\ig] Microsoht Expression Design 4

» If the starting file is not correctly displayed in MS Expression Design, it can still be
subsequently edited and optimized here

ED: Select

» Highlight the element for WPF export with the direct selection arrow in MS Expression
Design; in this case it is the whole clock

ED: Start export

»  Start the export via File -> Export

» the dialog for configuring the export settings opens

19 ] 129



5. ED: Export settings

» Enter the following export settings:
a) Format: XAML Silverlight 4 / WPF Canvas

Always name objects: Activate with tick

Place the grouped object in an XAML layout container: Activate with tick
b) Text: Editable text block

c) Line effects: Rasterize all

The exported file has .xaml file suffix. It is prepared and animated (on page 20) in MS Expression Blend
in the next stage.

4.2.3 Animation in Blend

With MS Expression Blend:
»  static XAML files from MS Expression Design are animated
»  Variables for controlling effects that can be addressed by zenon are created

In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon:

1. EB:create project

Q

Open Microsoft Expression Blend

)
a)

Create a new project

&)

Select the Project type of WPF- >WPF Control Library

@
~

Give it a name (in our tutorial: My_Project)

&

Select a location where it is to be saved
e) Select a language (in our tutorial: C#)

f)  Select Framework Version 3.5
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EB: delete MainControl.xaml.cs

a) Navigate to MainControl.xaml.cs
b) Delete this file using the Delete command in the context menu

EB: Open exported XAML file

a) Open the context menu for My_Project (right mouse button)

b) Select Add existing element...

c) Select the XAML file exported from Microsoft Expression Design, in order to open this in

Microsoft Expression Blend

EB: Open MainControl.xaml

a) Open the automatically created MainControl.xaml
b) In the Objects and Time axes area, navigate to the UserControl entry

EB: Adapt XAML code

a) Click on UserControl with the right mouse button

b) Select Display XAML in the contextual menu.

c) Delete lines 7 and 9 in the XAML code:
x:Class="My_Project.MainControl"

d:DesignWidth="640" d:DesignHeight="480"
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6.

EB: check XAML code

P The XAML code should now look like this:
<UserControl

xmIns=http://schemas.microsoft.com/winfx/2006/xaml/presentation
xmIns:x=http://schemas.microsoft.com/winfx/2006/xaml
xmIns:d=http://schemas.microsoft.com/expression/blend/2008
xmlns:mc="http://schemas.openxmliformats.org/markup-compatibility/2006"

mc:lgnorable="d"
x:Name="UserControl">

<Grid x:Name="LayoutRoot"/>

</UserControl>

EB: Copy elements

a)

Open the XAML file imported from Expression Design

&)

Mark all elements

Select Delete in the context menu

@
~

&

Change back to the automatically created XAML file

EB: Insert element

a) Click on Layout Root with the right mouse button

b) Select Insert
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10.

1.

12.

13.

EB: Adapt layout type

a) Click on Layout root -> Change layout type -> Viewbox with the right mouse button
b) The structure should now look like this: UserControl -> LayoutRoot -> Grid -> Elements
c) Assign a name for LayoutRoot and Grid by double-clicking on the names

EB: Texts and values

» Dynamic and static texts are labeled with text fields
P Values (numbers) are issued with Labels

EB: Insert labels

» Labels replace numbers that are to be subsequently linked using INT variables (must be
carried out for all number elements)

EB: Set property

» Todisplay 100%, set the bar graph element's MaxHeight property to 347 (the maximum
height of the indicator element is 340)

EB: prepare for use in zenon

a) Delete all name labels (names may only be given for elements that are to be addressed via
zenon)
b) Save the XAML file with any desired name
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C) Integrate the XAML file into zenon (on page 111)

A tip for checking: If the XAML file is displayed with no problems in Microsoft Internet Explorer and
the window size of Internet Explorer adapts to it, it will also be correctly used in zenon.

5 Guidelines for developers

This section handles the creation of simple WPF user controls with code-behind functionality using
Microsoft Visual Studio and debugging this user control in the Runtime.

The following tools were used for this:

P  Microsoft Visual Studio 2015

P zenon
¥ |nformation

Recommendation: Use Microsoft Visual Studio version 2012 or later. The XAML
designer is better integrated in this.

5.1 Creation of a simple WPF user control with code behind
function

The creation and incorporation of a simple user control is described in this chapter. Because only the
fundamental mechanisms/process for integration into zenon is described, the functionality of the user
control is limited to the addition of two values. There is intentionally no enhanced error handling or
explicit completion, in order to retain the simplicity of this example.

CREATE WPF USER CONTROL

1. Create a new Solution and a WPF User Control Library in this in Visual Studio.

The .NET framework version 4 was selected for this example. A different version can also be
selected, which must be installed on the target system on which Runtime will subsequently be
started.

Info: If the corresponding project template does not appear in the list of available templates,
this can be added by means of the search (field at the top right of the dialog).
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MNew Project

P Recent .MET Framework 4.3 ~ | Sort by: | Default - wpf user X -
4 |nstalled .
g WPF User Control Library Visual C# Type: Visual C=
-
4 Templates Windows Presentation Foundation user
" \l -
4 Visual C# WPF User Control Library Visual Basic control library
4 Windows
Universal
B Windows 8
Classic Desktop

Web

Android

Cloud

Extensibility

i0s

LightSwitch

Office/SharePoint

Silverlight

Tact -
P Online
Name: WPFUserControlLibrary
Location: [:h\sources - Browse...
Solution name: WPFUserControlLibrary Create directory for solution

[] Add to source control
[ ok || cancal

In our example, the project is given the name WPFUserControlLibrary.

2. Create 3 text boxes and a button in the UserControll.xaml file:

Enter a value

Add Values

i |Result

]

(38 HIE- ol P I
t = XAML
<UserControl x:Class="WPFUserContrelLibrary.UserControll”
xmlns="http://schemas.microsoft.com/winfx/2606/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2606,/xaml"
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
wmlns:d="http://schemas.microsoft.com/expression/blend/2008"
xmlns:local="clr-namespace:WPFUserControllibrary”
mc:Ignorable="d"
d:DesignHeight="126" d:DesignWidth="3@8">
<Grid Height="12@" width="Auto™>
<StackPanels
<TextBox x:Name="textBoxA" Height="38" TextWrapping="Wrap" Text="Enter a value" HorizontalAlignment="Stretch"/>
<TextBox x:Name="textBoxB" Height="38" TextWrapping="Wrap" Text="Enter a value"” HorizontalAlignment="Stretch"/>
<Button x:Name="buttonAdd” Height="38" Content="Add Vvalues™ HorizontalAlignment="Stretch” VerticalAlignment="Top" Click="buttonAdd Click"/»
<TextBox x:MName="textBox(C" Height="38" TextWrapping="Wrap" Text="Result" HorizentalAlignment="5tretch" IsReadOnly="True"/>
</StackPanel>
</Grid>
</UserControl>

3. Add the following code in the click event of the button:

private void buttonAdd_Click(cbject sender, RoutedEventirgs e)

1
try

1

textBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
catch (Exception ex)

textBoxC.Text = "Error adding values: " + ex.Message;

b
b
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Now you have the user control with the required functionality available. However, because zenon can
only display XAML files that do not link to a code-behind file, an additional XAML file is needed that
references the library (assembly) that has just been built.

CREATION OF THE XAML FILE (WITHOUT CODE BEHIND) FOR ZENON

Proceed as follows to create the XAML file required in zenon.
1. Create a further project, again as a WPF User Control Library
2. It was called WPFUserControlNoCodeBehind in our example.

3. Insert a reference to the project that has just been built into this new project.

Reference Manager - WPFUserControlNoCodeBehind

P Assemblies Search Projects (Ctrl+E) P~
4 Projects Name Path Name:
Solution | % WPFUserControllibrary ~ Di\sources\WPFUserCo[iita)) serControlLibrary

P Shared Projects
b COM

P Browse

| Browse... || OK || Cancel

4. The XAML files (UserControll.xaml) looks as follows:

<UserControl x:Class="WPFUserControlNoCodeBehind.UserControll™
xmlns="http://schemas.microsoft.com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2086/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:local="clr-namespace:WPFUserControlNoCodeBehind™
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="308">

<Grid>

</farid>
</UserControl>

5. Because all necessary content is contained in the DLL that has been created and no
code-behind file can be used, delete the following lines:

x:Class="WPFUserControlNoCodeBehind.UserControl1"

xmIns:local="clr-namespace:WPFUserControINoCodeBehind"
6. Also delete (for the designer's size setting) the following lines:

mc:lgnorable="d"

d:DesignHeight="300" d:DesignWidth="300"

7. Delete the code-behind file (UserControll.xaml.cs) in this project.
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8. Drag the user control that has been created beforehand (for the project
WPFUserControlLibrary) over the toolbox in the XAML designer.

9. Assign a name for the grid and the user control.

Attention: If no name is given here, these elements do not appear in the linking dialog in the
zenon Editor and thus cannot be made dynamic.

10. The XAML file should now look as follows:

- ful b
. |Enter & value
-

. |Enter a value

€
Add Values

B e

Result
n

S oEE - B4
o ExaML
<UserControl xmlns="http://schemas.microsoft.com/winfx/20@6/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:WPFUserControllibrary="clr-namespace:WPFUserControllibrary;assembly=WPFUserControllibrary™>
<Grid Name="MainGrid"»
<WPFUserControllibrary:UserControll Name="AdditionControl™ HorizontalAlignment="Left" VerticalAlignment="Top"/>
</Grid>
</UserControl>

In the next step, how the DLL and XAML file are incorporated into zenon is explained.

STEPS IN ZENON
1. Open the zenon Editor
2. Go to File -> Graphics.

3. Select Add file... in the context menu

8, User administration
I SAP nterface
£ Fles =
AE §
:5:] Loy Add file...
% R Folder new..
a3 Te Rename folde
=5 Dn Delete
) o
L History Editor profile »
@ Project
sbal symbol il Help = ]
n » 1

tree | B8 petwork topology

4. Select the XAML file at the save location (UserControll.xaml from the
WPFUserControlNoCodeBehind project) and add this:

FEMNECE R —RNEETE W S T M )

Status File name | Type Size Preview
r r r r r
UserControll xaml xaml 0KB

5. Insert the DLL with the functionality for the XAML file.
To do this:
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a) Select, in the context menu, File -> OtherAdd file....

b) Select the file WPFUserControlLibrary.dll (from the output path) of the first project

(WPFUserControlLibrary).

2 BB T BAX T LS H9
State| File name # | Type Size
r r r r
WPFUserControlLibrary.dll dil SKB

6. Create a zenon screen.

7. Add a WPF element and select the previously-incorporated XAML file.

You should now see the following in the zenon Editor:

L8 =
State| Name
r

Screen 0

By X B
i Sereen

4 Enter a value

Standa
Enter a value

‘ Add Values ‘

Result

8. Start zenon Runtime in order to also test the control there.

10

20

Add Values

30

¥ |nformation

The XAML file and referenced assemblies can also be saved in complied form as
a *.cdwpf file. Only one file thus need to be imported in the Editor (under Files
-> Graphics). Further information on this can be found in the CDWPF files
(collective files) (on page 48) chapter.

Hint: When developing a WPF user control, it is usually more practical to insert

the XAML file and the referenced DLL(s) separately. This makes the replacement
of the DLL and debugging easier. Further information on the topic of debugging
can be found in the Debugging the WPF user control in the Runtime (on page

29) chapter.
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Hint

DLLs that are part of a WPF element can also be replaced during ongoing
operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:

»

»

»

Close all zenon screens in which the WPF element is used.
Close all symbols that use a desired WPF element.

In Explorer, replace the DLL in the \wpfache folder of the Editor files.
You can find this folder in the SQL directory under
.\PROJECT-GUID\FILES\zenon\custom\wpfcache

As an alternative to replacement using Explorer, you can also replace the file in
the zenon Editor directly. To do this, carry out the following steps:

4

4

4

4

4

In the Visual Studio project settings, increase the file version of the DLL.
Create the new DLL.

Close all zenon screens in which the WPF element is used.

Close all symbols that use a desired WPF element.

In the zenon Editor, delete the DLL from the \Files\Other folder and add the
file with the higher version number.

Further examples can be found in the Examples: Integration of WPF into zenon (on page 111) chapter.

5.2 Debugging the WPF user control in the Runtime

To debug the WPF user control in the Runtime, proceed as follows.

In this example, the control described in the Creation of a simple WPF user controls with code behind
function (on page 24) is used.

DEBUGGING BY MEANS OF ATTACH TO PROCESS

Ensure that zenon Runtime has been started and a screen with the WPF user control is open.

Furthermore, ensure that the DLL that is currently being used corresponds to the build (Version)
of the user control project (WPFUserControlLibrary).

29| 129



28 Bl
29
30
31
® 2
33
34
35
36
37
38

Attach to Process

Set a breakpoint in the click event of the button in the Visual Studio project

private void buttonAdd_Click(cbject sender, RoutedEventirgs e)

1
try

1
b

catch (Exception ex)
{
textBoxC.Text = "Error adding values: " + ex.Message;
b
b

extBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();

In Visual Studio, under Debug, select the Attach to Process menu item.

Select the zenon Runtime process

Transport:

Qualifier;

Transport Information
The default transport lets you select processes on this computer or a remote computer running the Visual Studio Remote Debugger

Default ~

v Find...

(MSVSMON.EXE).
Attach to: Automatic: Managed (v4.6, v4.5, v4.0) code Select...
MAyailable Processzes
Process D Title Type G
ZenSysSrv.exe 46280 xb4

Zenrt32.exe zenon Energy Edition Managed (v4.0.30319), Managed (v2.0.50727), x86

ZEMOME32. exe 8532 zenon Energy Edition Managed (v4.0.30319), Managed (v2.0.50727), x86

zenon_startup.exe 7048 x26

zenDB5rv.exe 17256 xb4

XDesProc.exe 14528 Managed (v4.0.30319), x86

XDesProc.exe 4a92 Managed (v4.0.30319), x86

XDesProc.exe B6TE Managed (v4.0.30319), x86

WhkSvMgr.exe 11080 x26

WIRNAIMEN EYE S10R T e

£ >
[ Show processes from all users Refresh

5. Under Attach to, select either Automatic or the corresponding .NET framework version (v4.x in

this case)

ect Code Type

(®)Automatically determine the type of code to debug:

() Debug these code types:

Native

Script

GPU - Software Emulator ~
Managed (CoreCLR)

Managed (v3.5, v3.0, v2.0)

Managed (v4.6, v4.3, v4.0)

6. Click on Attach
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7. Now trigger the breakpoint in which you enter values into the WPF control in zenon Runtime
and click on the button

28 = private void buttonAdd_Click(cbject sender, RoutedEventirgs e)
29 {
1 EL try
20 i
Qo 32 fextBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.Tolnt3:
33 ¥ | & textBoxC.Text| Q ~ "30" = |
wEalEls 34 catch (Exception ex)
30 35
36 textBoxC.Text = "Error adding values: " + ex.Message;
Autos Locals Watch1 + X Find Symbol Results Find Results Call Stack
Mame Value
& textBoxA Text "0
K& textBoxB. Text 20"

DEBUG USING START EXTERNAL PROGRAM

1. Ensure that zenon Runtime has been closed.

2. Ensure that, in the zenon Editor, the project that contains the WPF user control has been set as
the start project.

3. Ensure that the user control project (WPFUserControlLibrary) is set as the start project in Visual
Studio.

fa] Solution "WPFUserControlLibrary' (2 projects)

NPFUserControllibrarn

b | % Build
4 Rebuild
A
Clean
4 View 3
3 Analyze 3
b

Scope to This
MNew Selution Explorer View
¥, Show on Code Map

Build Dependencies 3
Add 3
Manage NuGet Packages...

Start Memory Profiler
Debug with Memory Profiler
Set as StartUp Project

S E =

4. In the project properties of the Visual Studio project, select under Debug, for Start action: Start
external program

5. For Start external program, select the path of the zenon Runtime application.

6. Under Working Directory, select the \wpfcache folder of the Runtime files
(...\PROJECTNAME\RT\FILES\zenon\custom\wpfcache)
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10.
1.

Hint: In the selected project in the zenon Editor, press the keyboard combination CTRL+ALT+R
in order to jump directly to the root directory of the Runtime files.

Build Events Start Action
Debug*®
O st prject
Resources
(® Start external program: |0 Files (x86)\COPA-DATA\zenon 7.50 SPONZenrt32.exe
Services
Settings (O Start browser with URL:
Reference Paths Start Options
Signing ]
Command line arguments:
Code Analysis

Working directory: |ER\TESTP ROJECT\RT\FILES\zenon'.custo m\wpfcache|

In the project properties, enter \wpfache folder of the Runtime files as the  Output path under
Build .

Output

Output path: |ER\TESTPROJECT\RT\FILES\Zenon\custom\wpfcache Browse...

Create the project in Visual Studio

Start debugging in Visual Studio with Start

b Start - |
I

zenon Runtime is now started automatically.

Trigger the breakpoint by entering values in the WPF control in zenon Runtime and click on the
button

28 = private void buttonAdd_Click(cbject sender, RoutedEventirgs e)
29 {
1 EL try
20 31
Qo 32 fextBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.Tolnt3:
33 } |ﬁ textBoxC.Text| O, ~ "30" =|-|
wEalEls 34 catch (Exception ex)
30 35 {
36 textBoxC.Text = "Error adding values: " + ex.Message;
Locals Watch1 & X Find Symbol Results Find Results Call Stack
Mame Value
& textBoxA Text “10"
K& textBoxB. Text 20"
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¥ |nformation

When starting zenon Runtime, the assemblies (DLLs) referenced in the WPF user
controls from the \FILES\zenon\custom\additional folder, and/or the assemblies
from CDWPF files in the \FILES\zenon\custom\wpfcache folder are copied. If the
file version of the DLL in the \wpfache folder is one higher than the version of
the "original file", it is not replaced!

For debugging, it is thus sufficient to only replace the file that is on the \wpfache
folder directly.

For delivery, it must be ensured that the current version of the DLL is present in
the \additional folder or the CDWPF file!

Attention: If only the DLL is updated in the \additional folder or in the CDWPF,
but the version number is not increased, the DLL must be deleted manually in
the \wpcache folder, because it is not updated otherwise (due to the
above-described mechanism).

Hint

DLLs that are part of a WPF element can also be replaced during ongoing
operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:

4

4

4

Close all zenon screens in which the WPF element is used.
Close all symbols that use a desired WPF element.

In Explorer, replace the DLL in the \wpfache folder of the Editor files.
You can find this folder in the SQL directory under
..\PROJECT-GUID\FILES\zenon\custom\wpfcache

As an alternative to replacement using Explorer, you can also replace the file in
the zenon Editor directly. To do this, carry out the following steps:

»

»

»

In the Visual Studio project settings, increase the file version of the DLL.
Create the new DLL.

Close all zenon screens in which the WPF element is used.

Close all symbols that use a desired WPF element.

In the zenon Editor, delete the DLL from the \Files\Other folder and add the
file with the higher version number.
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5.3 Data exchange between zenon and WPF user controls
There are different possibilities for exchanging data between zenon and WPF user controls.
» Data exchange using dependency properties (on page 34)

» Data replacement via VSTA (on page 38)

5.3.1 Data exchange using dependency properties

The most elegant and secure way to exchange data between zenon and self-created WPF user controls
is by using Dependency Properties.

The WPF user control project created in the Creating a simple WPF user controls with code behind
function (on page 24) serves as a basis (WPFUserControlLibrary).

In this chapter, the focus is purely on the core theme (Dependency Properties and data exchange
between the user control and zenon in this case). Specific WPF features such as Databinding, etc., as
well as explicit error handling, are not covered.

ADDITIONS TO THE CODE
1. Create the TextChanged Event for the textBoxA element in the file UserControll.xaml
TextChanged="textBoxA_TextChanged"
2. Add the following lines of code in the UserControl1 class of the code behind file
(UserControll.xaml.cs)
/// <summary>
/// Gets or sets the ValueA.
/// </summary>

public double ValueA

{
get

{
return (double)GetValue(ValueADependencyProperty);

}

set

{

SetValue(ValueADependencyProperty, value);
}
}

341129



/// <summary>

/// Dependency property for ValueA

/// </summary>

public static readonly DependencyProperty ValueADependencyProperty =
DependencyProperty.Register("ValueA", typeof(double),

typeof (UserControll), new FrameworkPropertyMetadata(©.0, new
PropertyChangedCallback(OnValueADependencyPropertyChanged)));

/// <summary>

/// Called when [value a dependency property changed].
/// </summary>

/// <param name="source">The source.</param>

/// <param name="e">The <see cref="DependencyPropertyChangedEventArgs"/> instance containing the
event data.</param>

private static void OnValueADependencyPropertyChanged(DependencyObject source,
DependencyPropertyChangedEventArgs e)

{

UserControll control = source as UserControll;
if (control != null)

{

try

{

control.ValueA = (double)e.NewValue;
control.textBoxA.Text = control.ValueA.ToString();
}

catch (Exception)

{}

}

}

/// <summary>
/// Handles the TextChanged event of the textBoxA control.
/// </summary>
/// <param name="sender">The source of the event.</param>

/// <param name="e">The <see cref="TextChangedEventArgs"/> instance containing the event
data.</param>

private void textBoxA_TextChanged(object sender, TextChangedEventArgs e)

{
try

{
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ValueA = Convert.ToDouble(textBoxA.Text);

}
catch (Exception)

{}
}

Then build the solution.
¥ Information

A numerical property (double) is used in this example. Other simple data types
(such as bool, string, int, etc.) can also be used.

LINKING IN ZENON
1. Update the WPF user control (DLL) in the zenon Editor.

2. Proceed as described in the creation of a simple WPF user controls with code behind function
(on page 24) chapter.

3. Create a numeric variable in zenon. Link this variable to a dynamic text element. You place the
dynamic text element in the screen next to the WPF element with your user control.

4. Open the screen that contains the WPF element and select, for the WPF element, under WPF
links: Configuration

WPF links
-0 Effects Ganfignratmre] Click h
[P, - onfiguration: Click here ->
) Visibility/flashing
) General
) Position
) Runtime

) Authorization
L.-i75 WPF links
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5. Expand the node in the tree at the top left and select AdditionControl

WPF element

WPF element
Available elements Preview

1+ MainGrid
- AdditionControl

Enter a value

Enter a value

Add Values

Result

Action link

Properties Events | Transformations

Linked | MName Linkage # Type of link | WPF info ~

T T T T T
[ ValueA P o
] Content <MNaothing lin... | System.Windows.Con...

6. Select the line with ValueA (this is the name of the property that was created in the code
beforehand) and select, for Type of link: Variable

Hint: Give Properties a prefix so that this can be found more easily, for example: _ValueA

7. In the column under Linkage, print out the variable that was created in zenon beforehand

Enter element

Link variable
QK

Linked variable
myZenonVariableA m Cancel
Range of values of the WPF element Help

[ convert range of values

Minimum Maximum
[v] 0

8. Confirm the dialog with OK and build the Runtime files

9. Start Runtime in order to test the WPF user control

10 10

Enter a value

‘ Add Values ‘

Result
10. If the value is changed in user control, the value automatically changes in zenon and vice versa.

11. You can of course debug the control as described in the Debugging the WPF user control in
Runtime (on page 29) chapter, and create further dependency properties.
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The UserControl_Loaded event can be used in order to (automatically) access
the values of the dependency property during initialization (when calling up the
user control) for example.

5.3.2 Data replacement via VSTA

Data can also be exchanged between zenon and WPF user controls using VSTA.

The API element methods
» get WPFProperty (reading of values)
» set WPFProperty (writing of values)

are used for this.

The example used here is based on the example used in the Data exchange using dependency
properties (on page 34) chapter.

CREATION OF A VSTA MACRO FOR DATA EXCHANGE BETWEEN ZENON AND
THE WPF USER CONTROL

1. Create the following VSTA macro in the project add-in of the zenon project

n V5TA and a WPF User Control

{

//Get the Screen and Element hosting the WPF User Control
ure myWPFScreen = this.DynPictures().Item("Screen");

zenCn.IElement myWPFElement = myWPFScreen.Elements(].Item("WPF_E;eme:t"];
//Read the current value from the WPF Element property
double currentValue = C::ve::.ToDouble(myWPFElement.get_WPFProperty("AdditiD:CD:t:D;", "ValueR") ) ;

//Double the walue and write it back to the WPF Element property
myWPFElement.set WPFProperty ("ARdditionControl", "ValueRA", currentValue * 2);

Whereby:
P "Screen" is the name of the zenon screen in which the WPF element is located
» "WPF_Element" is the name of the WPF element that contains the WPF user control

» "AdditionControl" is the name of the WPF user controls itself (defined in the
UserControll.xaml file)

» "ValueA" is the name of the user control property
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2. Create an execute VSTA macro function and link this to a button in the screen in which the WPF
element is also located

3. Start Runtime to test changes

64 l Read and double value

Enter a value

‘ Add Values ‘

Result

When executing the macro, the value is read by the control, doubled and written back.
* Information

The user control properties used for this method of data exchange need not
necessarily be dependency properties, as outlined in this example. "Standard"
properties can also be used, see in relation to this the Access via VSTA "variable
link" (on page 39) chapter.

5.4 Access to the zenon (Runtime) object model from a WPF
user control

There are different possibilities for access to the zenon object model from a WPF user control. This is
explained in more detail in the following chapters.

A Attention

When using zenon COM objects with self-created user controls or external
applications, they must be enabled using the Marshal.ReleaseComObject
method. Enabling by means of the Marshal.FinalReleaseComObject method
must not be used, because this leads to a malfunction of zenon Add-ins.

5.4.1 Access via VSTA "variable link"

In order to get access to the zenon Runtime COM interface by means of "variable link", proceed as
follows. The creation of a simple WPF user controls with code behind function (on page 24) serves as an
initial example.
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The following code is intended to show an example of how the COM
implements access to zenon Runtime and in doing so limits itself to the basic
functionality. There is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

a1 Solution "WPFUserControlLibrary' (2 projects)
4 WPFUserControllibrary
b Properties

Reference Manager - WPFUserControlLibrary

P Assemblies

b Projects MName Version

b Shared Projects WPDSp 1.0 Type L.ibrary 1.0

wschAPl 1.0 Type Library 1.0

4 COM Wscui.cpl 1.0 Type Library 1.0

WSHControllerLibrary 1.0

WUAPI 2.0 Type Library 20

Recent K5Editor ActiveX Control module 1.0

X5Manitoring ActiveX Control module 1.0

b Erowse XP5_SHL_DLL 1.0 Type Library 1.0

XP5_SHL_DLL 1.0 Type Library 1.0

zenDB5rv 3.0 Type Library 3.0

zenMetSrv 3.0 Type Library 3.0

zenon programming interface library 1.0

After this, the following code must be inserted in the UserControl1 class:

//The zenon Project

zenOn.Project zenonProject = null;

/// <summary>

/// Property for the Variable link via VSTA
/// </summary>

public object zenonVariablelLink

{

get { return null; }

set

{

if (value != null && zenonProject == null)

{

zenOn.Variable zenonVariable;
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try

{

zenonVariable = (zenOn.Variable)value;

}

catch (Exception)

{

return;

}

if ((zenonVariable!= null) && (!string.IsNullOrEmpty(zenonVariable.Name)))
{

zenonProject = zenonVariable.Parent.Parent;

}
}
}
}

/// <summary>

/// Trigger used to notify the control from VSTA to release the COM resources
/// </summary>

public object zenonReleaseTrigger

{

get { return null; }

set

{

if ((bool)value && zenonProject != null)
{

try

{
Marshal.ReleaseComObject(zenonProject);
}

catch (Exception)

{

return;

}

zenonProject = null;

GC.Collect();
GC.WaitForPendingFinalizers();
GC.Collect();

}
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Whereby access to the properties zenonVariableLink (to initialize the COM object) and
zenonReleaseTrigger (to unlock the COM object) are subsequently accessed from VSTA (write).

In order to test the COM access quickly very easily, it is possible to insert the following line of code in
the existing button click event of the user control.

private void buttonAdd_Click(object sender, RoutedEventArgs e)
{

if (zenonProject != null)

{

MessageBox.Show(zenonProject.Name);

}

return;

¥ |nformation

A zenOn.Project variable is used in this example. Of course other objects such as
events, etc. of the zenon object model can also be used.

NECESSARY AMENDMENTS IN THE ZENON PROJECT/VSTA CODE

The following steps are necessary in the VSTA code:

Creation of a VSTA macro for the initialization

/// <summary>

/// Macro for API initialization in the WPF User Control

/// </summary>

public void MacroWPFInit()

{

zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");

zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");

myWPFElement.set WPFProperty("AdditionControl”, "zenonVariableLink", this.Variables().Item(®0));
}

Creation of a VSTA macro for approval

/// <summary>
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/// Macro for API release in the WPF User Control

/// </summary>

public void MacroWPFRelease()

{

zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");
myWPFElement.set_WPFProperty("AdditionControl”, "zenonReleaseTrigger", true);
}

Create two execute VSTA macro functions that are linked with buttons, which are in the same screen as
the WPF element.

Now start Runtime in order to test the functionality
» Execute the macro for initialization

»  Click on the button in the WPF user control; a message box with the project name of the
project appears

T

Enter a value

Enter a value

Add Values

Result

TESTPROJECT

P Execute the macro for release

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF
user control in Runtime (on page 29).
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® Hint

The initialization and release of the COM object in this example is only carried
out for simple demonstration using VSTA macro functions. Depending on the
application, and/or in practice, events in VSTA are better suited to this.

For example, the code for initialization in the _Open event of the screen can be
executed with the WPF element and the code for release in the Close event.

The mechanism described here is also used in the Display of WPF elements in
the zenon Web Client (on page 107) chapter.

A Attention

If COM objects are used in WPF user controls, these must always be explicitly
approved before destroying the WPF user control (before closing the screen,
before closing Runtime, before reloading).

5.4.2 Access via marshaling

In order to get access to the zenon Runtime COM interface by means of marshaling, proceed as follows.
The creation of a simple WPF user controls with code behind function (on page 24) serves as an initial
example.

¥ |nformation

The following code is intended to show an example of how the COM
implements access to zenon Runtime and in doing so limits itself to the basic
functionality. There is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).
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Firstly, a reference to the zenon COM interface must be incorporated.

a1 Solution "WPFUserControlLibrary' (2 projects)
4 WPFUserControllibrary
b Properties

Reference Manager - WPFUserControlLibrary

P Assemblies

b Projects MName Version

b Shared Projects WPDSp 1.0 Type L.ibrary 1.0

wschAPl 1.0 Type Library 1.0

4 COM | Wscui.cpl 1.0 Type Library 1.0

WSHControllerLibrary 1.0

WUAPI 2.0 Type Library 20

Recent K5Editor ActiveX Control module 1.0

X5Manitoring ActiveX Control module 1.0

b Erowse XP5_SHL_DLL 1.0 Type Library 1.0

XP5_SHL_DLL 1.0 Type Library 1.0

zenDB5rv 3.0 Type Library 3.0

zenMetSrv 3.0 Type Library 3.0

zenon programming interface library 1.0

After this, the following code must be inserted in the UserControl1 class:
//The zenon Project

zenOn.Project zenonProject = null;

Furthermore, the constructor of the user controls must be supplemented with the lines below (to
initialize the COM object):

/// <summary>

/// Constructor for UserControll, initialize COM Object
/// </summary>

public UserControll()

{

InitializeComponent();

try
{

zenonProject =
((zenOn.Application)Marshal.GetActiveObject("zenOn.Application"”)).Projects().Item("TESTPROJECT")

3

}

catch (Exception)

{
}
}

The COM object must be approved in the UserControl_Unloaded event:
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/// <summary>

/// Release COM Object

/// </summary>

private void UserControl_Unloaded(object sender, RoutedEventArgs e)
{

try

{

if (zenonProject != null)

{
Marshal.ReleaseComObject(zenonProject);
zenonProject = null;

}

}

catch (Exception)

{

}

}

In order to test the COM access quickly very easily, it is possible to insert the following line of code in
the existing button click event of the user control.

private void buttonAdd_Click(object sender, RoutedEventArgs e)

{

if (zenonProject != null)

{
MessageBox.Show(zenonProject.Name);
}

return;

Now build the solution and update the WPF user control in the zenon project.
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Start Runtime to test the user control.

Enter a value

Enter a value

Add Values

Result

TESTPROJECT

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF
user control in Runtime (on page 29).

¥ |Information

A zenOn.Project variable is used in this example. Of course other objects such as
events, etc. of the zenon object model can also be used.

A Attention

If COM objects are used in WPF user controls, these must always be explicitly
approved before destroying the WPF user control (before closing the screen,
before closing Runtime, before reloading).

¥ |nformation

No access by means of marshaling is possible in the zenon web client. If access
to the COM interface is required there, the method described in the Access via
VSTA "variable link" (on page 39) must be used.

6 Engineering in zenon

In order to be able to use WPF user controls in zenon, version 3.5 (or higher, depending on the .NET
framework version used in the user control) of the Microsoft framework must be used on both the Editor
computer and the Runtime computer.
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CONDITIONS FOR THE WPF DISPLAY IN ZENON

The dynamization is currently available for simple variable types (numerical data types as well as string).
Arrays and structures cannot be dynamized.

Therefore the following WPF functions can be implemented in zenon:
» Element properties that correspond to simple data types, such as String, Int, Double, Bool etc.
» Element properties of the "Object" type, which can be set with simple data types

» Element events can be used with functions; the parameters of the events are not however
available in and cannot be evaluated in zenon

» Element transformation, for which a RenderTransform is present for the element in the XAML
file

Attention: if the content is outside of the area of the WPF element during transformation, this
is not labeled

Notes on dBase: No shade can be displayed in zenon for WPF elements.

4 Attention

If the Runtime files were created for a project for a version before 6.50, existing
WPF elements are not included into Runtime screens.

6.1 CDWPF files (collective files)

A CDWPF file (with the suffix *.cdwpf) is a renamed ZIP file that contains the following components:
»  XAML file (to reference the user control assembly)
» DLL file (the actual WPF user control, optional)
»  Preview graphics (for preview, optional)
Rules for the use of collective files:
»  The files (XAML, DLL, preview graphics) can be in the CDWPF file directly or in a joint folder.
The name of the collective file should correspond to the names of the XAML file.

Only one XAML file may be contained.

v v v

The preview graphic should be small and no more than 64 pixels high.
Name of the preview file: preview.png or the name of the XAML file with the suffix png.

»  Any number of assemblies can be used. The distinction is made on the basis of the file version.

» Collective files do not need to contain an assembly.
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»  All subfolders are examined and only taken into account with *.dll, *.xaml or *.png files.

» If a collective file (*.cdwpf) is replaced by a file with a different version, all corresponding
CDWPF files in all symbols and images in all projects must be adapted.

6.2 create WPF element
To create a WPF element
1. In the elements toolbar, select the symbol for WPF element or the Elements entry in the menu
Select the start point in the main window.
Pull open the element with the mouse.

2.
3
4. In properties, select Representation the property XAML file in the group.
5. The file selection dialog opens.

6

Select the desired file
Files of the following formats are valid:

» *xaml: Extensible Application Markup Language
» *.cdwpf: WPF collective file, also shows preview image

(The file must already be present in the Project Manager under Files/graphics or created in the
dialog.)

7. Configure the links (on page 49).
¥ Information

If referenced assemblies are used, note the instructions in the Referenced
assemblies (on page 8) chapter.

6.3 Configuration of the linking
To configure a WPF element
1. In properties, select WPF links the property Configuration in the group.

2. The dialog with three tabs opens with a preview of the XAML file and the elements present in
the file
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DIALOG CONFIGURATION

Configuration
W/PF element

WPF glement
Avalable elements

LayoutRoot
=1 MyViewBox
MySutton

Action nk

Properties  Events | Transformations

Preview

Button

Lirked | Name

Linkage

Type of ink | WPFinfo

ContetMenuService.Horizont...

L. Ll Content int Variable Butten |
=] IsEnabled Autherization available Authorizatio.. True
[0  DataContext <nathing lin...
(m] ContentStringFormat <nothing lin...
(] CommandTarget <nething lin...
(m] Uid <naothing lin...
O  MaxHeight <nothing lin... +unendlich
] Tag <nothing lin...
O  ToelTip <nothing lin...
O  CommandParameter <nothing lin...
(m] ToclTipService.Vertical Offset <nething lin... 0
O MaxWidth <nething lin... +unendlich
]
[m]
|

Typography.AnnotationAltern...
ContethlenuSanics Vadticalll

<nothing lin... 0

<nothing lin... 0
caothinalin 0

Available elements

Preview

Properties (0N page 51)

Events (on page 58)

Shows the named file elements in a tree structure.
The selected element can be linked with process
data.

WPF is assigned to process data based on the
element name. Therefore elements are only shown
if they and the attendant elements have a name.
Allocations are configured and shown in the
Properties, Events, Transformations tabs.

Hint: If the corresponding elements are not
displayed, check whether the non-displayed
objects in the XAML file have been given a name
(for example: <Grid Name="GridName">).

The selected element is shown flashing in the
preview.

Configuration and display of properties (variables,
authorizations, interlockings, linked values).

Configuration and display of events (functions).
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Transformations (on page 59) Configuration and display of transformations.
Name Name of the property.

Linkage Selection of link.

Type of link Type of link (variable, authorization, function)
WPF info Shows the current value for properties in WPF

content. For the user, it is directly visible what type
of property it is (Boolean, string, etc.).

Linked Shows if a property is currently being used.

If not contained in the view, can be selected via
Context menu->Column selection.

¥ |Information

Only logical objects can be displayed in the configuration dialog. Visual objects
are not displayed. You can read background information and how visual objects
can be animated in the Allocation of zenon object to WPF content.

EDIT HYPERLINKS

All configured hyperlinks can be edited from the properties of the element. Click on the element and
open the property group WPF links. Hyperlinks can be further configured here, without having to open
the dialog.

Limitations:
» The linking type cannot be changed here.
» New linkings can only be created via the configuration dialog.

» Insertion of a WPF elements into a symbol: WPF linkings cannot be exported.

6.3.1 Properties

The properties enable the linking of:
» Variables (on page 53)
» Values (on page 55)
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» Authorizations and interlockings (on page 56)

Configuration =]
WPF element
WPF element Ll
Avalable elements Preview —I|
LayoutRoot
= MyViewBox Tl
MyButton
Action bnk
Properties  Events | Transformations
Linked | Name Linkage # Type of ink | WPF info
L. Ll Content int Variable Butten |
=] IsEnabled Authorization available Authorizatio.. True
O  DataContext <ngthing lin...
(m] ContentStringFormat <nothing lin...
(] CommandTarget <nething lin...
O ud <nothing lin...
O  MaxHeight <nothing lin... +unendlich
] Tag <nothing lin...
O  Toolip <nething lin...
O  CommandParameter <nothing lin...
(m] ToclTipService.Vertical Offset <nething lin... 0
O MaxWidth <nething lin... +unendlich
O  ContetMenuService.Horizont... <nothing lin... 0
[m] Typography.AnnotationAltern... <nothing lin... 0
1| ContethanuSanice Vericall) cnathina lin 01
Parameter Description
Name Name of the property.
Linkage Linked variable, authorization or linked value.

Clicking in the column opens the respective
selection dialog, depending on the entry in the Link

type column.
Type of link Selection of linking.
WPF info Shows the current value for properties in WPF

content. For the user, it is directly visible what type
of property it is (Boolean, string, etc.).

Linked Shows if a property is currently being used.

If not contained in the view, can be selected via
Context menu->Column selection.

CREATE LINK

To create a link:
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Highlight the line with the property that is to be linked
Click in the Link type cell

Select the desired link from the drop-down list.

The following are available:

»  <not linked> (deletes an existing link)

»  Authorization/Interlocking

» Constant value

» Variable

Click in the Link cell

The dialog for configuring the desired link opens
¥ Information

Properties of WPF and zenon can be different. If, for example the visibility
property is linked, there are three values available in .NET:

» 0O -visible

» 1-invisible

» 2-collapsed

These values must be displayed via the linked zenon variable.

6.3.1.1 Link variable

To link a variable with a WPF property:

1.

oo W N

Highlight the line with the property that is to be linked
Click in the Link type cell

Select from the variable drop down list

Click in the Link cell

The dialog for configuring the variables opens
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This dialog also applies for the selection of variables with transformations (on page 59). The
configuration also makes it possible to convert from zenon into WPF units.

Configuration @

Link variable

Linked variable ILI

Range of values of the WPF element

Convert range of values
Minimum Maximum

Parameter Description
Linked variable Selection of the variable to be linked. A click on the

... button opens the selection dialog.
Range of values of the WPF element Data to convert variable values into WPF values.
Convert range of values Active: WPF unit conversion is switched on.

Effect in the Runtime: The current zenon value
(incl. zenon unit) is converted to the WPF range
using standardized minimum and maximum values.

For example: The value of a variable varies from
100 to 200. With the variables, the standardized

range is set to 100 - 200. The aim is to display this
change in value using a WPF rotary knob. For this:

» for Transformations, the
RotateTransform.Angle property is linked
to the variables

» Adjust value activated

» a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of
150, for example, by 180 degrees.

Minimum Defines the lowest WPF value.
Maximum Defines the highest WPF value.

oK Accepts settings and ends the dialog.
Cancel Discards settings and ends the dialog.
Help Opens online help.
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6.3.1.2 Link values

Linked values can either be a Str
the selected value is sent in WPF

ing or a numerical value of the type Double. When selecting the screen,

content after loading the WPF content.

To link a value to a WPF property:

1.

2. Click in the Link type cel
3. Select Value linkings fro
4. Click in the Link cell

5.

Highlight the line with the property that is to be linked

m the drop-down list

The dialog for configuration of value linking opens

Configuration
Link constant value
Linked value

Use string

Mumeric value

Unit

<Base unit>

==l

Cancel
Help

Parameter

Linked value:

Use string

String value/numerical
value

Unit:

Entry of a numerical value or string value.
Active: A string value is used instead of a numerical value.

The language of string values can be switched. The text is
translated in the Runtime when the screen is called up and sent
in WPF content. If the language is switched whilst the screen is
opened, the string value is retranslated and sent.

Depending on what is selected for the Use string property, a
numerical value or a string value is entered into this field. A unit
of measurement can also be selected for numerical values.

Selection of a unit of measurement from the drop down list. You
must have configured this in unit switching beforehand.

The unit of measurement is allocated with the numerical value. If
the units are switched in the Runtime, the value is converted to
the new unit of measurement and sent to WPF content.
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CLOSE DIALOG

Coptins - s

OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.

6.3.1.3 Link authorization or interlocking

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level.
Authorizations are granted within the user level for individual controls. If an authorization is active, the
value 7 is written to the element.

To link a user authorization or interlocking to a WPF property:

1. Highlight the line with the property that is to be linked

2. Click in the Link type cell
3. Select Authorization/interlocking from the drop down menu
4. Click in the Link cell
5. The dialog for configuring the authorizations opens
Configuration @
Link authorizationfinterlocking
Linked status
Cancel
Help
Link authorization/interlocking Setting the authorizations.
Linked status Selection of an authorization that is linked to a WPF

control from the drop down list. For example, visibility
and operability of a WPF button can depend on a user's
status.
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Configuration

Link authorization finterlocking |

e
-] Cancel
| Authorization available P —
Authorization does not exist Help
Mot interlocked

Interlocked
Can be operated
Cannot be operated

Authorization

Authorization granted

Authorization does not exist

Not interlocked
Interlocked

Can be operated

Cannot be operated

If the user has sufficient rights to operate the WPF element, a
value of 7 is written to the property.

If the user does not have sufficient rights to operate the WPF
element, a value of 7 is written to the property.

If the element is not locked, the value 7 is written to the property.
If the element is locked, the value T is written to the property.

If authorization is present and the element is not locked, then a
value of 7 is written to the property.

If authorization is not present or the element is not locked, then
a value of T is written to the property.
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6.3.2 Events

Events make it possible to link zenon functions to a WPF element.

Configuration @
WPF element
|
Avaiable elements Preview Cancel
:
Help
- -

Button

Properties | EVENts | Transformations | User authorization/Interiocking

WPF event Linked function
ContextMenuClosing Function 1
ContextMenuOpening Function 2
DataContextChanged Function 3
DragEnter

Cragleave

DragQver

Crop

FocusableChanged

GiveFeedback
GotFocus

Name Name of the property.

Linkage Linked function. Clicking in the cell opens the
configuration dialog.

Type of link Selection of linking. Clicking in the cell opens the
selection dialog.

WPF info Shows the current value for properties in WPF
content. For the user, it is directly visible what type
of property it is (Boolean, string, etc.).

Linked Shows if a property is currently being used.

If not contained in the view, can be selected via
Context menu->Column selection.

LINK FUNCTIONS

To create a link:
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1. Highlight the line with the property that is to be linked

2. Click in the Link type cell
3. Select from the drop down list function
4. Click in the Link cell
5. The dialog for configuring the function opens
Configuration @
Link function
Linked function ILI
< no function linked = D Cancel
Help
Linked function Selection of the function to be linked. Clicking on
the ... button opens the dialog for Function
selection.
OK Accepts selection and closes dialog.
Cancel Discards changes and closes dialog.
Help Opens online help.

6.3.3 Transformation

The WPF element does not support rotation. If, for example, the WPF element is in a symbol and the
symbol is rotated, the WPF element does not rotate with it. Therefore there is a different mechanism
for Transformation with WPF to turn elements or to otherwise transform them. These transformations
are configured in the Transformation tab.
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Attention: If the content is outside of the WPF element area, this part of the contents is lost or it is not

shown.
Configuration @
WPF element
L« |
Available elements Preview Cancel
LayoutRoot
=I-MyViewBox Helo ]

r n

Button

| Properties | Events Transformations _dserauhrlzal:imﬁnheﬂoddrq

WPF transformation Linked variable
RotateTransform. Angle WIZ_VAR_10
RotateTransform. CenterX Alarms not adnowledged

RotateTransform. CenterY
ScaleTransform. CenterX
ScaleTransform, CenterY
ScaleTransform. ScaleX
ScaleTransform, ScaleY
SkewTransform. AngleX
SkewTransform, AngleY
SkewTransform, CenterX

Name Name of the property.

Linkage Selection of the linked variables.

Transformations are displayed in XAML as transformation objects with
their own properties. If an element supports a transformation, then the
possible properties of the transformation object are displayed in list
view. (more on this in: Integrate button as WPF XAML in zenon (on
page 115)

For example, if the linked variable is set at the value of 70, then this
value is written as a WPF target and the WPF element is rotated by 10°.

Type of link Selection of transformation link type.

WPF info Shows the current value for properties in WPF content. For the user, it is
directly visible what type of property it is (Boolean, string, etc.).

Linked Shows if a property is currently being used.

If not contained in the view, can be selected via Context
menu->Column selection.
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LINK TRANSFORMATIONS

To link a transformation with a WPF property:

1. Highlight the line with the property that is to be linked
Click in the Link type cell
Select from the Transformation drop down list

Click in the Link cell

oA W

The dialog for configuring the variables opens

The configuration also makes it possible to convert from zenon into WPF units.

Configuration @
Linked variable I—IOK
D Cancel
Range of values of the WPF element
Convert range of values
Minimum Maximum

Linked variable Selection of the variable to be linked. A click on the
... button opens the selection dialog.

Range of values of the WPF element Data to convert variable values into WPF values.
Convert range of values Active: WPF unit conversion is switched on.

Effect in the Runtime: The current zenon value
(incl. zenon unit) is converted to the WPF range
using standardized minimum and maximum values.

For example: The value of a variable varies from
100 to 200. With the variables, the standardized

range is set to 100 - 200. The aim is to display this
change in value using a WPF rotary knob. For this:

» for Transformations, the
RotateTransform.Angle property is linked
to the variables

» Adjust value activated

» a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of
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150, for example, by 180 degrees.

Minimum Defines the lowest WPF value.
Maximum Defines the highest WPF value.

OK Accepts settings and ends the dialog.
Cancel Discards settings and ends the dialog.
Help Opens online help.

6.4 Validity of XAML Files

XAML files are valid subject to certain requirements:
»  Correct name spaces
» No class references

»  Scalability

CORRECT NAME SPACE

The WPF element can only display WPF content, i.e.:

Only XAML files with the correct WPF namespace can be displayed by the WPF element. Files that use
a Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change
the Silverlight namespace to the WPF namespace.

WPF-Namespaces:
xmlns="http.//schemas.microsoft.com/winfx/2006/xaml/presentation"

xmlns:x="http.//schemas.microsoft.com/winfx/2006/xaml"

NO USE OF CLASS REFERENCES

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain
references to classes ("class" key in header). Functions that have been programmed in
independently-created C#- files cannot be used.

In order to use WPF user controls with code behind, the process as described in the Creating a simple
WPF user control with code behind funciton (on page 24) must be carried out.
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SCALABILITY

If the content of a WPF element is adjusted to the size of the WPF element, then the controls of the
WPF element are interlaced in a control that offers this functionality, such as a view box for example. In
addition, it must be ensured that the height and width for this elements are configured as automatic.

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT

To check if an XAML file has the correct format:
»  Open XAML file in Internet Explorer

» Ifit can be opened without additional plug-ins (Java or similar), then it can be assumed
with a high degree of certainty that this file can be loaded or displayed by zenon

» if problems occur during loading, these are then shown in Internet Explorer and the lines in
which problems arise can be clearly seen

The scaling can also be tested in this manner: If the file has been created correctly, the content will
adjust to the size of the Internet Explorer window.

ERROR MESSAGE

If an invalid file is used in zenon, then an error message is displayed in the output window when loading
the file in the WPF element.

For example:

"error when loading
xaml-Datel:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-al73-08563¢c3142e9\FILES\zenon\cu
stom\media\UserControll.xaml

The attribute "Class" cannot be found in XML namespace
"http.//schemas.microsoft.com/winfx/2006/xaml". Line 7 Position 2."

6.5 Pre-built elements

Registered zenon partners can obtain examples of WPFs via MyArea
(https://www.copadata.com/en/my-area/overview/) on the COPA-DATA website.

zenon is already shipped with several WPF elements. More are available for download in the web shop.

All WPF elements have properties which determine the graphical design of the respective element
(Dependency Properties). Setting the values via an XAML file or linking the property via zenon can
directly change the look in the Runtime. The tables in the description of the individual elements contain
the respective Dependency Properties, depending on the control.

Available elements:
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Analog clock (on page 64)

Vertical bar graph (on page 65)
BACnet WPF Control

Comtrade Viewer (on page 66)
Energy class diagram (on page 78)
Progress bar (on page 66)

Pareto diagram (on page 79)
Sankey Diagram (on page 86)
Round display (on page 82)
Temperature control  (on page 87)

Universal slider (on page 88)

v VvV Vv VvV VvV VvV VvV VvV VvV 9v Vv v

Waterfall chart (on page 90)

REPLACING ASSEMBLY WITH A NEWER VERSION

Per project only one Assembly for a WPF element can be used in the zenon Editor as well as in the
Runtime. If two versions of an Assembly are available in a project, then the first loaded file is used. A user
enquiry is made as to which version should be used. No further actions are needed for the maintenance
of the versions used up until now. If a newer version is chosen, all corresponding CDWPF files in all
symbols and images in all projects must be adapted.

Note for Multi-Project Administration: If an Assembly in a project is replaced by a new version, it
must also be replaced in all other projects that are loaded in the Editor or in Runtime.

6.5.1 Analog clock - AnalogClockControl

ElementStyle Shape/type of element. Enum:

»  SmallNum

bers
»  BigNumber
s
» No
ElementBackgroundBrush  Color of element background. Brush
ElementGlasReflection Activate the glass effect on the element. Visibility
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Offset

OriginText

Value in hours (h) which displays the time lag to

the system clock.

Text which is displayed in the clock (e.g.

location).

6.5.2 Bar graph vertical - VerticalBargraphControl

CurrentValue
MinValue

MaxValue
MajorTicksCount
MinorTicksCount
MajorTickColor
MinorTickColor
ElementBorderBrush

ElementBackgroundBru
sh

ElementGlasReflection
ElementFontFamily
ScaleFontSize
ScaleFontColor
IndicatorBrush
BargraphSeparation

BargraphSeparationCol
or

Current value which should be displayed.

Minimum value of the scale.
Maximum value of the scale.
Number of main ticks on the scale.
Number of sub ticks on the scale.
Color of main ticks on the scale.
Color of sub ticks on the scale.
Color of the element border.

Color of element background.

Activate the glass effect on the element.

Element font.

Font size of the scale.

Font color of the scale.

Bar graph fill color.

Number of bar graph dividion.

Color of the scale division.

Int16

String

Double
Double
Double
Integer
Integer
Color
Color
Brush

Brush

Visibility
Font
Double
Color
Brush
Integer

Color
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6.5.3 Progress bar - ProgressBarControl

CurrentValue
MinValue
MaxValue

ProgressbarDivisionCoun
t

Visibility Text

TextSize

TextColor
ProgressBarBoxedColor

ProgressBarMarginDistan
ce

ProgressBarlnactiveBrush
ProgressBarActiveBrush

ProgressBarPadding

ElementBorderBrush

ElementBackgroundBrus
h

Current value which should be displayed.
Minimum value of the value area.
Maximum value of the value area.

Number of divisions of the progress bar.

Visibility of the value display.

Font size of the value display.

Color of the value display.

Color of the border of the progress bar.

Distance of the progress bar box from the element edge
(left, top, right, down).

Indicator color not active.
Indicator color active.

Distance of the progress bar from the progress bar box
(left, top, right, down).

Color of the element border.

Color of element background.

6.5.4 COMTRADE-Viewer

Double
Double
Double

Integer

Boolean
Double
Color
Color

Double

Brush
Brush

Double

Brush

Brush

The COMTRADE-Viewer WPF element is available to partners of COPA-DATA and is available to them
via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

B License information

The COMTRADE-Viewer can only be configured in the zenon Editor with a valid
Energy Edition license. If there is no valid license, the WPF is displayed as grayed
out in the Editor. A valid Energy Edition license is also required for display in the

Runtime.

66 | 129


https://www.copadata.com/en-us/partner-community/

Engineering in zenon ﬂ

Zenon

The control supports the graphical analysis of digital error and event data logging of a COMTRADE file.
¥ Information

The control supports IEEE C37.111 (IEEE Standard Common Format for Transient
Data Exchange (COMTRADE) for Power Systems) standards-compliant files.
ASCII or binary files in accordance with the 1999 or 2013 edition can be
visualized.

Older files or files without a year identification are not supported. A warning
dialog is called up when an invalid/unsupported file is selected.
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Possibilities of the COMTRADE-Viewer WPF control in zenon Runtime:
P Selection of a file in the COMTRADE file format

»  Visualization of the selected COMTRADE file:
Note: The display colors can be configured in the zenon Editor.

»  Current (sinus wave display)
Voltage (sinus wave display)
Digital signals (binary bar chart display)

Display of values at a selected cursor position.

v v Vv Vv

If an element that represents neither current or voltage is selected, (such as frequency), this
is visualized in both analog areas again (current and voltage).

» Navigation:

» Zoom in and zoom out using the mouse wheel, scroll bar and Multi-Touch gestures
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» Enlargement of the area
Selection of the area by clicking the mouse

» Move the display area using the right mouse button, scroll bar or Multi-Touch gestures.

»  Exports selected objects as an CSV file.

% Hint

To be able to transport COMTRADE files to the zenon Runtime computer, you
can also use the file transfer of the IEC 61850 driver or the FTP function block of

zenon Logic.

You can find further information about this in the driver documentation of the
IEC 61850 driver or in the zenon Logic documentation.

6.5.4.1 View in Runtime

The COMTRADE WPF element offers two views in the Runtime:

» Configuration view
»  Selection of a COMTRADE configuration file
»  Selection of the elements to be displayed

»  Graph view

P Zoom in and zoom out

» Display of values at a selected cursor position.

»  Export of the selected elements as an CSV file

¥ |nformation

The switch between the views is integrated in the WPF element. Additional
project configuration of a screen switching function is not necessary.

6.5.4.2Installation

Requirements:

»  You must be a registered COPA-DATA Partner.

»  You need to have access to the COPA-DATA Partner Community already granted.
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TO DOWNLOAD A WPF ELEMENT:

1.

9.

10.

11.

12.
13.
14.

Open the COPA-DATA Partner Community
(https://www.copadata.com/en-us/partner-community/).

Log inin the area called MY AREA.

Enter "Partner" as a search term by the microscope.

COPA-DATA Partner Community appears with a link in the results.

Click on the link.

In the Partner Login Area, click on MORE.

The Overview tab is opened.

Switch to the Documents & Downloads tab.

Under SELECT CATEGORY, activate the WPF element checkbox.
Click on Search.

The labeling is hidden.

An orange frame surrounds the search field.

Click in the frame and enter COMTRADE.

The COMTRADE Viewer is shown.

Under Actions, click on the orange symbol to download the COMTRADE Viewer.

Save the folder locally.

Unzip the file.

Open the COMTRADE folder that contains the Comtrade.cdwpf file.

6.5.4.3 Installation

To create a WPF element

1.

G N oo A W N

Open the zenon Editor

In the project manager, go to Files and Graphics.

Go to Import file....

Select the file Comtrade.cdwpf for importing.

Confirm the selection by clicking on Open.

Open the screen in which the WPF element is to be inserted.

In the vertical menu bar, select the WPF element (WPF).

Drag the WPF element in the screen with the left mouse button.

The File selection window is opened.
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9. Select the file Comtrade.cdwpf and confirm the input by clicking on OK.
The WPF element is added.

6.5.4.4Configurable control properties - color display

ENGINEERING IN THE EDITOR

The element with the name COMTRADE.CDWPF can be configured and placed in each zenon screen

type.
The project configuration of Width [pixels] and Height [pixels] of the element depend on the

proportions. This prevents the COMTRADE-Viewer being displayed as distorted in Runtime.

Note: When configuring the project, ensure that there is sufficient size to guarantee a clear overview.

GRAPHICAL AMENDMENTS

You configure the graphic design in the properties of the WPF element.
You can find further information in the configuration of the linking (on page 49) chapter in this manual.

Possible color values:

» Hexadecimal color values in the following formats can be used:
#RRGGBB and #AARRGGBB
Transparency values are permitted.

» Example color values:
#000000 = black
#FFFFFF = white
#FFO000 = red

» Color values by name
Reference: https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx
(https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx)

% Hint

The properties for the COMTRADE-Viewer WPF element have a "Z" as a starting
color. Use name filtering for a clear display when configuring the linking.

CONFIGURATION PAGE

Text and background color of the configuration page.

Analog Channels
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zConfiguratinPageTextColor Text color of the configuration String
page
zConfigurationPageBackground  Background color of the String
Color configuration page
BUTTONS

Text and background color of the button.

Open...
zButtonTextColor Text color of the button String
zButtonBackgroundColor Background color of the button String
CHART

Text color of the axis labeling or key and background color.

T
50000 60000 70000

zChartTextColor Text color of the axis labeling. String
zChartBackgroundColor Background color of the axis String
labeling
LABEL

Text and background color of the display of a selected cursor position.

-1 544

12 208
zChartLabelTextColor Text color of the value display String
zChartLabelBackgroundColor Background color of the value String

display
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CHART

Color palette of the graph view and the attendant keys.

zChartPalette

Color palette of the colors for String
graphs and keys.

Referencing with color palette
name (see overview).

Default: if no color palette is
configured, the color palette of
the computer's operating system
is used.

POSSIBLE COLOR PALETTES - OVERVIEW

Arctic N RN
Autumn [l [ ][]
Cold | ] ] | |
Flower | |

Forest HEEN
Grayscale [N H | |
Ground | | [ | | |
Lilac | |

Natural [ | | ] [ ]
Pastel | |
Rainbow [l ||

Spring

Summer [l

Warm L[] ]
Windows3 [l HEN

6.5.4.5Runtime view - configuration page

If a screen with a configured COMTRADE-Viewer WPF element is called up, the display of the respective

configuration page is empty.
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Note: This also applies if, in zenon Runtime, there is a switch from one screen to another screen with
the screen switching function.

uoRenbyuo) 1BMSIA IAVYLINDD ~

COMTRADE VIEWER CONFIGURATION

The COMTRADE Viewer Configuration switching, arranged vertically on the side, switches the display of
the configuration to graphic view and vice versa.

SELECT FILE
The Open... button opens the file selection dialog to select a file.

There is a pre-selection for display in the file selection:

» Indoing so, file pairs of *cfg- and *.dat files are detected.
Note: Optional *hdr or *.inf files are not taken into account.

Only the corresponding *dat files are displayed.
All attendant files (*.dat, *.cfg) are loaded by clicking on the desired file and the OK button.

One file can be loaded.

v v Vv v

After loading the file, the contents of the file are shown in the Analog Channels and Digital
Channels columns.

The labels and units of the elements originate from the COMTRADE configuration and cannot
be changed.
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FURTHER INFORMATION ON THE EDITING OF _*.CFG- AND *.DAT FILES

The information from the *.cfg file allows the evaluation of the *.dat file. It contains the data from
various analog and digital series of measurements of currents and voltages. The data is broken down
into individual data sets and shown in hex format.

* cfg files

» The last entry of a file of this data type is a time multiplier. This entry is multiplied by the time
stamp of one of each entry from the *.dat file when a disturbance is read in. If there is no time
multiplier, a factor with the value of 1is assumed internally. The *.cfg file is not changed in the
process.

» Certain standards apply for the entries of the digital measured values. Example of a
standard-compliant entry of a digital measured value: 1,LOPHC,,,0. However, if there is no zero
at the end of the entry, the COMTRADE-Viewer adds this internally. The *.cfg file is not changed
in the process.

*.dat files

» The COMTRADE-Viewer is in a position to read in files of this data type that start with the index
0 or >1. In doing so, a check is constantly carried out to see whether these data sets are
numbered continually in discrete steps from 1. If there are data sets that are not correctly
numbered, the file cannot be read in.

ANALOG CHANNELS

[Liste der verfugbaren Kandle] Selection of the elements to be visualized.

Multiple selection by clicking on the desired entry
in the list. Selected elements are shown with a
colored background. Another mouse click undoes
the selection of the entry.

Select All Selects all elements from the list.

Deselect All Deactivates the existing selection of elements.

DIGITAL CHANNELS

[Liste der verfugbaren Kandle] Selection of the elements to be visualized

Multiple selection by clicking on the desired entry
in the list. Selected elements are shown with a
colored background. Another mouse click undoes
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the selection of the entry.

Select All Selects all elements from the list.
Deselect All Deactivates the existing selection of elements.
SHOW SELECTION

To show your selection in the graphic view, click on the Apply button.

Note: Clicking on the vertically-arranged COMTRADE Viewer Configuration switching only changes the
view. An amended selection of the channels is not taken into account in the process.

6.5.4.6 Runtime view - visualization of COMTRADE data

The selected channels are visualized in the graph view of the COMTRADE-Viewer WPF element. The
coloring can be configured in the zenon Editor.

Files that are compliant with the IEEE €37.111-2013 (or IEC 60255-24:2013) standard can be read in.

X-values are necessary for the display, which represent the time stamps of the respective recorded data
points.

The X-values can be saved in the *.dat file directly.

If this is not the case, there is a calculation of the time stamp using the following entries of the *.cfg file:
»  Start time of recording the disturbance (date and time of the first data point)
»  Number of recorded data points (Samplerate)

»  Number of data points for each query (Rate)

EXPORT OF THE SELECTED DATA

The selected analog and digital channels can be exported to a CSV file with the CSV-Export button.

GRAPH VIEW

The graph view of the COMTRADE-Viewer is divided into three sections:

»  Current amperage
Upper area

» Voltage
Mid area
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AXIS LABELING

KEY

4

Horizontal axis

Zenon

The horizontal axis represents the complete time period as illustrated in the COMTRADE file

(*dat).

The scaling of this time axis depends on the enlargement level. The higher the enlargement

selected, the more detailed the time display.

Vertical axis
The vertical axis represents the values.

» The scaling of the value axis depends on the enlargement level. The greater the
enlargement selected, the more detailed the display of values.

» The labeling of the analog channels is shown vertically next to the values and corresponds

to the measuring unit as defined in the COMTRADE file (*.cfg).

» The digital channels are displayed in the sequence as defined in the COMTRADE file (*.cfg).

The Channel identifier of the COMTRADE file serves as an identifier.

Tiaa) BiBA) MICK) ©IGA)

The color key of the graphs is shown at the head of the graph.
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» The labeling of the digital channels corresponds to the channel description as defined in the
COMTRADE file (*cfg).

» The colors for each channel are assigned automatically with the configured color palette.

» The time is displayed in a footer under the graph. The start time is displayed as a text.

NAVIGATION AND ZOOM

Navigation (scroll and zoom) is always applied to all three areas of the graphic display.
»  You can move the display within the horizontal time line with the scroll bar.
» Zoom in and zoom out

»  You can zoom at the current position of the mouse pointer in the graph view or reduce the
enlargement.

» The selected area is displayed by selecting a display area with the mouse button held
down.

Note: The display of the values is always amended to the selected area. As a result, this
can lead to a flattening of the curve in the enlarged graph view.

» Double clicking on the scroll bar resets the enlargement.

ANALYSIS

200
150

X000
PV VY
Y

-200

The precise values at the position of the mouse pointer are visualized with a display in value blocks. A
crosshair offers additional visual support with the exact determination of the reading position.

77129



6.5.5 Energy class diagram

The energy class diagram, WPF element is available to partners of COPA-DATA and is available to them
via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

<18.00 kW A
18.00 - 25.00 kKW B ﬂ
35.00 - 50.00 kW D

> 50.00 kW =

A reaction matrix must be used to model an energy class diagram. This reaction matrix must be linked
to the variable whose value is envisaged for display and distribution in energy classes. The name of the
variable must be transferred to the "zVariableName" property.

REACTION MATRIX FOR ENERGY CLASS DIAGRAM

L01Total_ EC_RC
States and reactions
States Function
Walue Status <No function linked > Cancel
< 1s . Call via button in screen Alarm Message List Help
[1 18 25
[1 25 35 Additional attributes
[1 35 52 Limit value color [CFlashing
» 58
-l Cinvisible
Help file
Help chapter
Additional information 1
| v]
Additional information 2
Mew status Delete Test Up Down | bl |
Status
=M1 I& M2 & m3 = ma & ms & ms &7 & ms
= nET _sEL = revision 5| proGRess & C E ) = ore = R & rM_TR
=] ALt _vaL = sponT &= n_uppaTE
Value AMLfCEL
[Jin Alarm Message List
Any To acknowledge Comment required
Two-stage adknowl — send adknowledgement
Print to CEL
[(in Chronological Event List
Limit value text
E |
Alarm Event Group
[treat each change of value as new limit violation | 0 - <Unused> ~ |
Delay time [s] State number for counter in the mathematics driver Alarm Event Class
= w | 0 - <Unused: w |

The linked reaction matrix must correspond to the following schematic:
»  The first status must be an area, or a "less than" definition

» Then as many different areas as desired can be defined.
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» The last status must be an area or a "greater than" definition.

The following is applicable for project configuration:

1. If the first status is an area and the value of the variable comes under this area, the first status in
the diagram is shown nevertheless. The same is applicable for the last status the other way
round.

2. The colors that the WPF diagram uses for the classes are the limit value colors that were
defined in the reaction matrix.

3. The letters for the classes are set in alphabetical order starting with "A".

zenonFontID ID for a font from the first font list (font size is  Integer
not taken into account)

zenonNumberOfDecimalPlaces Number of displayed decimal points Integer

zenonVariableName Name of the variable to be displayed. String

Note: Additional VSTA programming is necessary for the display of the energy class diagram in the
zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on
page 107).

6.5.6 Pareto diagram

The Pareto diagram, WPF element is available to partners of COPA-DATA and is available to them via
the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

An example of a Pareto diagram in Runtime is shown below:

100%

25%

o

o

=
o
=1
=1

00.00

Speed Losses
Minor Stops
Breakdown
Cleaning
Unplanned Break
Quality Losses
Changeover

Unplanned Maintenance

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:
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zenonBarColor1

zenonBarColor2
zenonBarColor3
zenonBarColor4
zenonBarColor5
zenonBarColor6
zenonBarColor7
zenonBarColor8
zenonBarColor9

zenonBarColor10

zenonColorPercentagelin

e

zenonlnitialisationTime

zenonlineVisibility

zenonVariablel_Label

zenonVariable1l Value
zenonVariable2_Label
zenonVariable2_Value
zenonVariable3_Label
zenonVariable3 Value
zenonVariable4 _Label
zenonVariable4 Value
zenonVariable5 Label
zenonVariable5_Value

zenonVariable6_Label

Color of the first Bar

Color of the second Bar
Color of the third Bar

Color of the fourth Bar

Color of element fifth Bar
Color of element sixth Bar
Color of element seventh Bar
Color of element eighth Bar
Color of element ninth Bar
Color of element tenth Bar

Color of the percentage line (relative sum
frequency).

Denotes how long the wait for the
initialization of controls is.
Visibility of the percentage line (relative
sum frequency).

Labeling for the 1st Bar

Value of the 1st Bar

Labeling for the 2nd Bar

Value of the 2nd Bar

Labeling for the 3rd Bar

Value of the 3rd Bar

Labeling for the 4th Bar

Value of the 4th Bar

Labeling for the 5th Bar

Value of the 5th Bar

Labeling for the 6th Bar

COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)
COLOR (STRING)

INTEGER
Default; 150 ms

BOOLEAN

STRING
DOUBLE
STRING
DOUBLE
STRING
DOUBLE
STRING
DOUBLE
STRING
DOUBLE

STRING
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zenonVariable6_Value
zenonVariable7 Label
zenonVariable7 Value
zenonVariable8 Label
zenonVariable8 Value
zenonVariable9 Label

zenonVariable9 Value

zenonVariable10 Label

zenonVariable10 Value

Value of the 6th Bar
Labeling for the 7th Bar
Value of the 7th Bar
Labeling for the 8th Bar
Value of the 8th Bar
Labeling for the 9th Bar
Value of the 9th Bar
Labeling for the 10th Bar

Value of the 10th Bar

The following events can be used and linked to zenon functions:

zenonBar1Click

zenonBar2Click

zenonBar3Click

zenonBar4Click

zenonBar5Click

zenonBar6Click

zenonBar7Click

zenonBar8Click

zenonBar9Click

Function that is executed when the 1st bar
is clicked on.

Function that is executed when the 2nd
bar is clicked on.

Function that is executed when the 3rd bar
is clicked on.

Function that is executed when the 4th bar
is clicked on.

Function that is executed when the 5th bar
is clicked on.

Function that is executed when the 6th bar
is clicked on.

Function that is executed when the 7th bar
is clicked on.

Function that is executed when the 8th bar
is clicked on.

Function that is executed when the 9th bar
is clicked on.

DOUBLE
STRING
DOUBLE
STRING
DOUBLE
STRING
DOUBLE
STRING

DOUBLE

Function

Function

Function

Function

Function

Function

Function

Function

Function
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zenonBar10Click

Function that is executed when the 10th
bar is clicked on.

6.5.7 Circular gauge control

CurrentValue
IsReversed
ElementFontFamily
MinValue
MaxValue
ScaleRadius
ScaleStartAngle

ScaleLabelRotationM
ode

ScaleSweepAngle
ScaleLabelFontSize
ScaleLabelColor
ScaleLabelRadius
ScaleValuePrecision

PointerStyle

Current value which should be displayed.
Scale orientation - clockwise or anti-clockwise.
Element font.

Minimum value of the scale.

Maximum value of the scale.

Radius of the scale.

Angle at which the scale starts.

Alignment of the scale caption.

Angel area which defines the size of the scale.
Font size of the scale caption.

Font color of the scale caption.

Radius on which the scale caption is orientated.

Accuracy of the scale caption.

Shape of the pointer displaying the value.

Function

Double
Boolean
Font
Double
Double
Double
Double

Enum:
» None

» Automati
C

»  Surround
n

»  Surround
Out

Double
Double
Color

Double
Integer

Enum:
»  Arrow

» Rectangl
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MajorTickColor
MinorTickColor
MajorTickSize
MinorTickSize
MajorTicksCount

MajorTicksShape

MinorTicksShape

MinorTicksCount

PointerSize

PointerCapRadius

PointerBorderBrush

PointerCapStyle

Color of main ticks on the scale.
Color of sub ticks on the scale.
Size of main ticks on the scale.
Size of sub ticks on the scale.

Number of main ticks on the scale.

Shape/type of main ticks on the scale.

Shape/type of sub ticks on the scale.

Number of sub ticks on the scale.
Size of the pointer.
Size of the pointer fastening point.

Color of pointer border.

Shape/type of pointer fastening point.

e
» TriangleC
ap
» Pentagon
» Triangle
Color
Color
Size
Size
Integer
Enum:
» Rectangl
e
» [rapezoi
d
» Triangle
Enum:
» Rectangl
e
» Trapezoi
d
» Triangle
Integer
Size
Double
Brush
Enum:
» BackCap
» FrontCap
» Screw
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PointerCapBorderBr
ush

PointerBrush
GaugeBorderBrush

GaugeBackgroundBr
ush

PointerCapColorBrus
h

GaugeMiddlePlate
PointerOffset
RangeRadius
RangeThickness
RangeStartValue

RangexEndValue

RangexColorBrush

Color of pointer fastening point.

Color of pointer.
Color of the element border.

Color of element background.

Color of pointer fastening point.

Radius of the element background middle plate.
Offset of the pointer (displacement).

Radius of the total range display.

Thickness of the total range display.

Start value of the total range display.

End value of an area. x stands for the range. The end
value is at the same time the start value of the next
respective range:

» RangelEndValue: End value of the st area
and start value of the 2nd range.

» Range2EndValue: End value of the 2nd area
and start value of the 3rd range.

» Range3EndValue: End value of the 3rd area
and start value of the 4th range.

» Range4EndValue: End value of the 4th area
and start value of the 5th range.

» Range5EndValue: End value of the 5th area
and start value of the 6th range.

» Range6EndValue: End value of the 6th range.

Color of the respective area. x stands for the range.
Available are:

» RangelColorBrush: Color of the first range.

» Range2ColorBrush: Color of the second
range.

Brush

Brush
Brush

Brush

Brush

Double
Double
Double
Double
Double

Double

Brush
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ScaleOuterBorderBru
sh

ScaleBackgroundBru
sh

ValueTextFrameStyle

ValueTextContent

ValueTextSize
ValueTextColor
IsGlasReflection

GaugeOffsett

» Range3ColorBrush: Color of the third range.
» Range4ColorBrush: Color of the fourth range.

» Range5ColorBrush: Color of element fifth
range.

» Range6ColorBrush: Color of element sixth
range.

Note: Cannot be set in zenon. You can find
information on the use of CDWPF to change color
values in the chapters Referenced assemblies (on page
8), CDWPF files (on page 48) and Configurable control
properties - color display (on page 70).

Color of the scale border.

Color of scale background.

Shape/type of value display.

Content of the value display.

Font size of the value display.
Font size of the value display.
Activate the glass effect on the element.

Lowering the rotation point of the whole element.

Brush

Brush

Enum:

» LargeFra
me

»  SmallfFra
me

» None

» Text

» TextValu
e

» Value
Double
Color
Boolean

Double
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6.5.8 Sankey Diagram

The Sankey diagram, WPF element is available to partners of COPA-DATA and is available to them via

the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The Sankey wizard must be used to model a Sankey diagram. The wizard creates an XML file that is then
evaluated by the WPF element. To do this, the zSankeyName property must be given the name of the

XML file. The XML file must be in the Other folder of a project. This is saved there by the wizard.

An example of a Sankey diagram in Runtime is shown below:

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

FontSize

zBackgroundColor

zFontColor

zFontFamily

zLossDetectionActive

zNoDataText

zNoValidXMLText

ZNumberOfDecimalPlace
s

zPreviewActive

Font size of the texts.

Background color of the diagram.

Color of the texts.

Font of all texts.

Automatic loss detection
activated/deactivated. If true, then losses are
automatically shown at a node points as flows.

Text that is displayed if there are no values to
display and zPrevireActive s false.

Text that is displayed if no valid XML file with
entered name has been found and
zPreviewActive is false.

Denotes how many decimal places are to be
displayed.

Display of a preview activated/deactivated.
The preview can be displayed if

There is no data present (the modeled
diagram is filled with default values) or

the XML file was not found or

this does not contain a valid definition (an

Integer

Color
(String)

Color
(String)

Font (String)

Bool

String

String

Integer

Bool
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zRefreshRate

zSankeyName

zShowRelativeValues

example Sankey diagram is displayed).

Rate at which the diagram is refreshed in ms.

Name of the XML file with the modeling of

the diagram.

Display of the values in absolute false or
relative values true.

Integer

String

Bool

Note: Additional VSTA programming is necessary for the display of the Sankey diagrams in the zenon
Web Client. You can find details on this in the display of WPF elements in the zenon Web Client (on

page 107).

6.5.9 Temperature indicator - TemperaturelndicatorControl

CurrentValue
MinValue
MaxValue
MajorTicksCount
MinorTicksCount

TickNegativColor

TickPositivColor

MinorTickColor
ElementBorderBrush

ElementBackgroundBru
sh

ElementGlasReflection
ElementFontFamily
IndicatorColor

IndicatorBorderColor

Current value which should be displayed.
Minimum value of the scale.

Maximum value of the scale.

Number of main ticks on the scale.
Number of sub ticks on the scale.

Color of the negative main tick (gradient to
TickPositivColor).

Color of the positive main tick (gradient to
TickNegativColor).

Color of the sub ticks.
Color of the element border.

Color of element background.

Activate the glass effect on the element.
Element font.
Color of the indicator fill color.

Color of the indicator border.

Double
Double
Double
Integer
Integer

Color

Color

Color
Brush

Brush
Visibility
Font

Color

Color
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MajorTickSize Size of main ticks on the scale. Size
MinorTickSize Size of sub ticks on the scale. Size

ScaleLetteringDistance  Distance of the scale caption (vertical), each x. main  Integer
tick should be captioned.

IndicatorScaleDistance  Distance between indicator and scale (horizontal). Double
ScaleFontSize Font size of the scale. Double
ScaleFontColor Font color of the scale. Color
Unit Unit. String
ElementStyle Shape/type of element. Enum:

» SmallFra

me
» Unit
» None

6.5.10Universal slider - UniversalReglerControl

CurrentValue Current value which should be displayed. Double
ElementFontFamily Element font. Font

MinValue Minimum value of the scale. Double
MaxValue Maximum value of the scale. Double
Radius Double
ScaleRadius Radius of the scale. Double
ScaleStartAngle Angle at which the scale starts. Double
ScaleLabelRotationMode  Alignment of the scale caption. Enum:

» None

» Automatic

» Surroundin
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ScaleSweepAngle
ScaleLabelFontSize
ScaleLabelColor
ScaleLabelRadius
ScaleValuePrecision

ElementStyle

MajorTickColor
MinorTickColor
MajorTickSize
MinorTickSize
MajorTicksCount

MajorTicksShape

MinorTicksShape

MinorTicksCount
BackgroundBorderBrush
BackgroundBrush

PointerCapColorBrush

Angel area which defines the size of the scale.
Font size of the scale caption.

Font color of the scale caption.

Radius on which the scale caption is orientated.

Accuracy of the scale caption.

Display type of the element

Color of main ticks on the scale.
Color of sub ticks on the scale.
Size of main ticks on the scale.
Size of sub ticks on the scale.
Number of main ticks on the scale.

Shape/type of main ticks on the scale.

Shape/type of sub ticks on the scale.

Number of sub ticks on the scale.
Color of the element border.
Color of element background.

Color of pointer fastening point.

»  SurroundO
ut

Double
Double
Color

Double
Integer

Enum:
» Knhob
» Plate

» None
Color
Color
Size
Size
Integer

Enum:
» Rectangle
» Trapezoid

» Triangle

Enum:
» Rectangle
» Trapezoid

» Triangle
Integer
Brush
Brush

Brush
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GaugeMiddlePlate
ValueFontSize
ValueFontColor
IsGlasReflection
KnobBrush
IndicatorBrush

IndicatorBackgroundBrus
h

KnobSize
KnoblndicatorSize
ElementSize
VisibilityKnob
ValuePosition

ValueVisibility

6.5.11 Waterfall chart

Radius of the element background middle plate.
Font size of the value display.

Font size of the value display.

Activate the glass effect on the element.

Color of the knob.

Color of the indicator.

Background color of the inactive indicator.

Diameter of the knob.
Indicator size of the knob.
Size of the element.
Activating of the knob.
Position of the value display.

Activating the value display.

Double
Double
Color
Boolean
Brush
Brush

Brush

Double
Size
Size
Boolean
Double

Boolean

The waterfall diagram WPF element is available to partners of COPA-DATA and is available to them
via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The Meaning and waterfall chart Wizard must be used to model a waterfall diagram. A waterfall can be
modeled with this wizard. The information is saved directly to the variables in the Parameters for
waterfall diagram property (Analyzer variable properties group).
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An example of a waterfall diagram in Runtime is shown below:

production Time | (o 023633 10000 %

Cleaning 0d 00:40:00 0251 %

Changeover 0d 00:00:00 00.00 %

Unpl. Maintenance 0d 00:59:31 03.73 %

Unplanned Break 0d 00:00:00  00.00 %
Breakdown | | 0d 05:18:30 19.95 %

operating Time [N 0d19:38:30 73.82%
Minor Stops | 0d07:33:31 2841%

speed Losses [ 0d 08:57:43 33.68 %

Net Operating Time [N 0d03:07:16 1173 %
Quality Losses 0d 00:02:43 0017 %

Valuable Operating [N 0d03:0432 1156%

Note: This screenshot is only available in English.

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

zenonRefreshRate Time between the refreshes of  Integer
the diagram in miliseconds.

zenonWaterfallldentifie Name of the waterfall diagram.  String
r

zenonZSystemModel Equipment group of the String
variables used.

Note: Additional VSTA programming is necessary for the display of the waterfall diagram in the zenon
Web Client. You can find details on this in the display of WPF elements in the zenon Web Client (on
page 107).

LINK BARS TO ZENON FUNCTION

The bars of a waterfall diagram can be linked to a function in the Runtime. For display in the Runtime,
the bars, labeling and display of the values for execution with the click of a mouse can be configured for
the waterfall diagram.

Carry out the following configuration to link the columns of your waterfall diagram to a function:

1. Configure the WPF element for the waterfall diagram.
Note: To do this, use the Meaning and Waterfall Chart wizard if possible.

2. Engineer a zenon function.

a) Create a new function:
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In the toolbar or in the context menu of the Functions node, select New function.
The dialog to select a function is opened.

b) Select the desired function.
C) Set the parameters for function.

3. Name the function in the Name property.
Note: The function name must contain the variables for the waterfall diagram without color
code!
You can also find these parameters in the Parameters for waterfall diagram variable property
in the Analyzer properties group.

4. Link the function to the exact same equipment group as the variables.
Note: You can find this linking in the Equipment Groups property of the function.

The following is applicable for this project configuration:
» The function and the linked variables must be present in the same zenon project.
» The variables must be linked to an equipment group.

» The function must be linked to the same equipment group as the variables.
B Example

For a bar with the waterfall definition WF= WFT1,02,05,#E9ED92; The function
name, for example Function_WF1,02,05, is to be used.

6.5.12BACnet WPF Control

The BACnet Schedule Control WPF element is available to partners of COPA-DATA and is available to
them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The control offers the possibility to configure BACnet schedule objects in a graphical user interface and
to display these objects.

6.5.12.1 Installation

Requirements:
»  You must be a registered COPA-DATA Partner.
» You need to have access to the COPA-DATA Partner Community already.
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DOWNLOAD WPF ELEMENT FROM THE COPA-DATA PARTNER PORTAL

Carry out the following steps to download the WPF element:

1.

10.

1.

12.
13.
14.

Open the COPA-DATA Partner Community
(https://www.copadata.com/en-us/partner-community/).

Log in in the area called MY AREA.

Enter "Partner" as a search term by the microscope.
COPA-DATA Partner Community appears with a link in the results.
Click on the link.

In the Partner Login Area, click on MORE.

The Overview tab is opened.

Switch to the Documents & Downloads tab.

Under SELECT CATEGORY, activate the WPF element checkbox.
Click Search.

The labeling is hidden.

An orange frame surrounds the search field.

Click in the frame and enter Bacnet.

The BACNetWPFScheduler is shown.

Under Actions, click on the orange symbol to download the BACnet Schedule Control.

Save the folder locally.

Unzip the file.

Open the folder that contains the files BacnetSchedulerControl xaml and

BacnetSchedulerWPF.dll.

IMPORT BACNET SCHEDULE CONTROL IN ZENON EDITOR

To create a WPF element

1.
2.
3.

Open the zenon Editor
Go to the Files node in the project manager.

Expand the view of this node by clicking on the [+] button.
The tree view is unfolded and the subnodes are displayed.

Go to the Graphics subnode.

a) Select the Import file entry in the tool bar of the detail view.
The file selection dialog is opened.

b) Select the file called BacnetSchedulerControl.xaml.
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c) Confirm the selection by clicking on the Open button
Go to the Miscellaneous subnode.

a) Select the Import file entry in the tool bar of the detail view.
The file selection dialog is opened.

b) Select the file called BacnetSchedulerWPF.dl.

c) Confirm the selection by clicking on the Open button

6.5.12.2 Engineering in the zenon Editor

Carry out the following steps to use the BacnetScheduler in zenon:

1.

Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

Change the properties of the screen:
a) Name the screen in the Name property.

b) Select a desired screen type in the Screen type property (recommended screen type:
Standard).

c) Select the desired frame in the Frame property.

Configure the content of the screen:

a) Open the screen in which the WPF element is to be inserted.

b) In the Elements tool bar, select WPF element (WPF) .

c) Drag the WPF element in the screen with the left mouse button.
d) The File selection window is opened.

e) Select the file BacnetSchedulercontrol.xaml and confirm the input by clicking on OK.
f)  The WPF element is added.

Amend the size of the WPF element to your zenon screen.

a) Highlight the desired WPF element.

b) Switch to the Position property group.

c) Setthe parameters for the element width using the Width [pixels] property and the height
with the Height [pixels] property.
Recommended minimum size: 920 x 920 pixels
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6.5.12.3 Configurable control properties

Enter element

WPF element

.
Available elements Preview
Cancel
[=)- BacnetControlGrid
B BacnetSchedulerControl From To Help
Effective Period
Datatype UNSIGNED =
Weekly Schedule
Exception Schedule
@ DateRange From |Select a date Day -
Action link
Properties Events | Transformations
Linked | Mame # | Linkage Type of link | WPF infa ~
w w w w w
[m] StartDate <Mothing lin... | 1/1/2019 12:00:00 AM
O EndDate <Mothing lin...  12/31/2019 12:00:00 AM
(] CurrentDataType <Maothing lin.. | UNSIGMED
[m] ZenonEffectivePeriod =Mothing lin...
[m] ZenonWeeklySchedule <MNothing lin...
[} ZenonExceptionSchedule =Mothing lin...
[} Content <MNothing lin... | System.Windows.Con...
[m} HasContent <Mothing lin..  True
[} ContentStringFormat <Mothing lin...
(] BorderThickness =<Mothing lin... | 0,0,0,0
[} FontSize <MNothing lin... | 12
[m} FontStretch <MNothing lin... Mormal
(] FontStyle <Meothing lin..  Mormal
[m] FontWeight <Mothing lin... | Normal
| HorizontalCantentAlinament Blothine lin treteh ~

Carry out the following steps to set the parameters for your BACnet WPF control:
1. Highlight the desired WPF element.

Switch to the WPF links property group.

Click the ... button in the Configuration property

The dialog to enter elements is opened.

oA W

Expand the BacnetControlGrid node in the Existing Elements area.
The BacnetSchedulerControl is visible in the node.

6. Click on the BacnetSchedulerControl entry.
The view in the Action Linkings area is updated.

7. Set the parameters for the WPF content:

a) Click once on the respective line in the Linking Type column.
A drop-down list is opened.

b) Select the corresponding linking type in the drop-down list.

c) Click in the Verkntipfung column to open the element input dialog.
This is amended to the configured linking type (for example, selection of a variable, entry of
avalue, ..)

8. Confirm your parameter settings by clicking on OK.
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POSSIBLE TYPES OF LINKING

One or more parameters can be linked for this WPF:
StartDate

EndDate

ZenoncEffectivePeriod

ZenonWeeklySchedule

v v Vv v Vv

ZenonExceptionSchedule
¥ Information

The setting of the parameters of the WPF element are visualized in zenon in the
WPF links properties group of the WPF element. In doing so, each WPF linking
is displayed with a separate subnode or property overview.
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6.5.12.4 Runtime view

From To Use Timespan

Effective Period | 1/1/2018 12/31/2018 Save
Weekly Schedule

Day Time Value

Mon 00:00:00.000 10] | load |

Tue 00:00:00.000 [0

Wed 00:00:00.000 [01 m

Thu 00:00:00.000 [0

Fr 00:00:00.000 [01 Save

Sat 00:00:00.000 [01

Sun 00:00:00.000 [0

Exception Schedule

@ DateRange  From | 9/12/2018 Day |Weec
() SingleDate To 9/12/2018 Day |Wec * | Priority [16 ~
) WeekNDay
) CalenderRef 000000
Time values

Event Type Period Priority Time Value

DateRange G/12/2018 - 9/14/2018 16 00:00:00.000 | [1] FALSE m
SingleDate 9/15/2018 16

‘WeekNDay July:days numbered 1-7:Monday 16 m
CalenderReference | 0000001 16

In zenon Runtime, existing BACnet schedule objects can be read by the PLC, modified in the Runtime
and saved back to the PLC.

The user interface in Runtime is divided into three areas:
» Effective Period
» Weekly Schedule
» Exception Schedule

Note: The graphical user interface is only available in English.
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6.5.12.4.1 Runtime view

From To [] Use Timespan

Effective Period

In this area, the value of the variable that has been linked in configuration of the control (on page 95) in
the Editor for the ZenonEffectivePeriod option is displayed.

Use Timespan The parameters for the Effective Period are set in
Runtime. Input is in the input fields From and To.

» Inactive:
The Effective Period is not used.

» Active:
The Effective Period is entered in Runtime.

Default: inactive

From Start of the Effective Period. Entry of the date.
Manual entry or selection from a calendar. The
calendar is displayed by clicking on the calendar
symbol as a drop-down dialog.

Default: 7. 7. 2018

Note: Only active if the Use Timespan option is
active.

To End of the Effective Period. Entry of the date.
Manual entry or selection from a calendar. The
calendar is displayed by clicking on the calendar
symbol as a drop-down dialog.

Default; 31. 72. 2078

Note: Only active if the Use Timespan option is
active.

Save Writes the current configuration for the Effective
Period to the PLC.
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6.5.12.4.2 Runtime view

Weekly Schedule

Day Time Value

In this area, the value of each variable that has been linked in configuration of the control (on page 95)
in the Editor for the ZenonWeeklySchedule option is displayed.

[List of the content of the loaded The schedule is displayed in the Weekly Schedule
Weekly Schedule] list as a list entry. The parameters are set for the
respective list entry:

»

Day
Selection of the day from a drop-down list.

Time
Entry of the time
Input format: hh:mm.ss:ms

Value
Value of the respective schedule. The value
represents the data type:
[0] = NULL
[1] = BOOLEAN
[2] = Unsigned
[3] = REAL
[5] = Double
[6] = OctetString
[7] = CharacterString
[8] = BitString
[9] = Enumerated
[10] = Date
[11] = Time
[12] = BACnetObjectldentifier

Default: [0]
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Note: Mandatory in the Values field when
configuring the data type. The data type is given as
a number according to the top list. Note that this
must be given in square brackets [].

Example: [7] for BOOLEAN.

In addition to the data type, the corresponding
value of the data type can also be configured. This
value is entered after the data type.

Examples:
[1] TRUE
For Boolean with value TRUE

[10] 2/3/2021
For data type date with value February 3, 2021
Date entry in BACnet standard format.

Load Reads the current configuration for the Weekly
Schedule from the PLC.

The loaded Weekly Schedule is displayed in the
Weekly Schedule list.

Note: With a Load, all unsaved configurations are
replaced with values from the PLC in Runtime
without a request for confirmation.

New Creates a new Weekly Schedule.

Delete Deletes the selected entry from the Weekly
Schedule list. The entry is deleted immediately
without a request for confirmation.

Multiple selection is possible, but is ignored when
clicking on Delete.

Save Writes the current configuration for the Weekly
Schedules to the PLC.
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6.5.12.4.3Runtime view

Exception Schedule

(O] DateRange From .Select a date . Day ¥
(0 SingleDate To .Select a date . Day | Priority ¥
() WeekNDay
() CalenderRef
Time values
Event Type Period Pricrity Time Value

In this area, the value of the variable that has been linked in configuration of the control (on page 95) in
the Editor for the ZenonExceptionSchedule option is displayed.

Type of Exception Schedule Type of schedule for exceptions (Exception
Schedule).
Selection from option box:

» DateRange
The Exception Schedule is defined with a
time period.
The time period is configured with the
options From, Day, To and Day .

» SingleDate
The Exception Schedule is defined with a
precise day.
The day is configured with the options
Single and Day.

»  WeekNDay
The Exception Schedule is defined with
several days.
These days are configured in the
drop-down lists for WeekNDay .

» CalenderRef
The Exception Schedule is defined with a
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Parameter

From
(for Eventtype DateRange)

Single
(for Eventtype SingleDate)

Day
(in From line)

To

reference to an existing BACNet calender
object.

Start of the Eventtype Exception Schedule. Entry of
the date.

Entry by means of manual entry or selection from a
calendar. The calendar is shown by clicking on the
calendar symbol as a drop-down dialog.

Default: empty (Select a date)

Note: Only active if the options DateRange or
SingleDate are active.

Weekday of the start of the Eventtype Exception
Schedule.

If a date is configured in the From option, the
corresponding weekday is automatically set for the
option.

Selection of the weekday from a drop-down list:

Mon
Monday

»

Tue
Tuesday

Wed
Wednesday

Thu
Thursday

Fri
Friday

Sat
Saturday

Sun
Sunday

Default: empty

Note: Only active if the options DateRange or
SingleDate are active.

End of the Eventtype Exception Schedule. Entry of
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Day

(in To line)

Priority

WeekNDay

the date.

Manual entry or selection from a calendar. The
calendar is displayed by clicking on the calendar
symbol as a drop-down dialog.

Default: empty (Select a date)

Note: Only active if the DataRange option is
active.

Weekday of the end of the Eventtype Exception
Schedule.

If a date is configured in the To option, the
corresponding weekday is automatically set for the
option.

Selection of the weekday from a drop-down list:

» Mon
Monday
» Tue
Tuesday
»  Wed
Wednesday
» Thu
Thursday
¥ Fri
Friday
» Sat
Saturday
»  Sun
Sunday

Note: Only active if the DataRange option is
active.

Priority for the Eventtype in accordance with
BACnet standard.Selection from drop-down list:
Values 7 - 176

Selection of the date for the Eventtype Exception
Schedule from drop-down lists.
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» Drop-down list 1:
Selection of the month
Note: The any month of year entry
corresponds to each month.

» Drop-down list 2:
Selection of the day in accordance with
prescribed criteria.
Drop-down list 3:
Selection of the weekday
Note: The any day of week entry
corresponds to each weekday of a week.

Note: Only active if the WeekNDay option is
active.

CalenderRef Reference to an existing BACnet CalendarObject
object.

Entry of the numerical Object Instance of the
BACnet object. This is always a seven-digit bit
number in accordance with the BACnet standard.

Valid input range (in accordance with BACnet
standard):
0 - 4194302

Note:

To achieve this, the Object Instance number
entered in the control must be filled with a 0 in
front.

Example:
CalendarObject Instance Nummer =1
Input in control = 0000007

[List of the content of the loaded » The schedule is displayed in the Expeption
Exception Schedule] Schedule list as a list entry. The parameters

are set with the listed options:

» Event Type:
Corresponds to the selection of the event
types from the option box.

» Period:
Display of the date. The display can vary
depending on the selected event type:
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[Date] - [Date]

»  Priority:
Configured priority

Load Reads the current configuration for the Exception
Schedules on the PLC.

The loaded Exception Schedule is shown in the list.

Note: With a Load, all unsaved configurations are
replaced with values from the PLC in Runtime
without a request for confirmation.

New Applies the configuration from the Exception
Schedule area and creates a new entry in the list.

Delete Deletes the selected entry from the Exception
Schedule list. The entry is deleted immediately
without a request for confirmation.

Multiple selection is possible, but is ignored when
clicking on Delete.

Save Writes the current configuration for the Exception
Schedules to the PLC.

TIME VALUES

Time values for a configured Exception Schedule Event.

[List of the configured Time values for the > Time

selected Exception Schedule Event] Entry of the time
Input format: hh:mm.ss:ms

» Value
Value of the respective schedule. The value
represents the data type:
[0] = NULL
[1] = BOOLEAN
[2] = Unsigned
[3] = REAL
[5] = Double
[6] = OctetString
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[7] = CharacterString
[8] = BitString
[9] = Enumerated
[10] = Date
[11] = Time
[12] = BACnetObjectidentifier

Default: [0]

Note: Mandatory in the Values field when
configuring the data type. The data type is given as
a number according to the top list. Note that this
must be given in square brackets [].

Example: [T] for BOOLEAN.

In addition to the data type, the corresponding
value of the data type can also be configured. This
value is entered after the data type.

Examples:
[1] TRUE
For Boolean with value TRUE

[10] 2/3/2021
For data type date with value February 3, 2021
Date entry in BACnet standard format.

New Creates a new Time value entry for the selected
Exception Schedule Event.

Delete Deletes the selected Time value entry. The entry is
deleted immediately without a request for
confirmation.

Multiple selection is possible, but is ignored when
clicking on Delete.

6.5.12.5 Operation in zenon Runtime

Possibilities of the BACnet Schedule Control in zenon Runtime:
» Time period for validity of the schedule (Effective Period)
» Configurable period of validity in days
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» Reading of the existing Effective Period from the PLC.
» Saving of the modified Effective Period on the PLC.
» Configuration of weekly schedules:
» Reading existing Weekly Schedules from the PLC.
» Configuration of new entries for the Weekly Schedule
» Deletion of existing entries
» Saving of the modified Weekly Schedules to the PLC
» Configuration possibility per entry:
- day (Day of the Week)
- time per day (local and UTC, depending on the PLC)
- data type and value
» Configuration of exceptions (Exception Schedule)
» Reading of existing exception schedule from the PLC.
» Configuration of new entries for the Exception Schedule.
» Deletion of existing entries.
»  Saving of the modified Exception Schedule to the PLC.
» Configuration possibility per entry:
- Event Type (DateRange, SingleDate, WeekNDay, CalenderRef)
- Period
- Priority
- Time

- data type and value

6.6 Display of WPF elements in the zenon web client

In order to also be able to also use the pre-made WPF elements "energy class diagram”, "Sankey
diagram” and "waterfall chart" for the display in a zenon web client, amendments are necessary in the
project:

» Engineering in the zenon Editor (on page 108)
» Adapt VSTA code (on page 108)
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6.6.1 Engineering in the zenon Editor

Carry out the following project configuration steps in the zenon Editor, in order to also be able to
display certain WPF elements in the zenon web client:

PLACE WPF IN THE ZENON SCREEN:

»
»

Place the WPF element in a zenon screen.

Give it a unique name in the Element ID property.

You can find this property in the General properties group.

Note: A warning dialog appears if the name for an element has already been issued in another
screen.

Use the element name issued here in the VSTA code.

6.6.2 VSTA code (complex)

In order to add the programmer code for the display of WPF elements in the zenon web client, carry
out the following steps:

1.

2.

S AW

In the zenon Editor, switch to the programmer interfaces node.

Select the VSTA node and select the Open VSTA Editor with project add-in... with a right mouse
click

The dialog to create a VSTA project is opened.
Select the C# entry in the Create new VSTA project dialog.
Create (copy) the code below.

Enter the name of the WPF element in the code.

Note: When opening the VSTA editor, note whether the content of the following code is already
present in the project configuration. For the display of the WPF element in the web client, compare the
existing code and undertake the necessary additions. Please note the comments in relation to this in the
sample code.

VSTA CODE

//As member:

zenOn.IDynPictures zScreens = null;

string[] WPFElements ={"WPF_Control", "WPFWebclient_1", "WPFWebclient_2" }; //Names of the WPF screen
elements that appear in the zenon project and that need access to the API (as many/few as you want)
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//Add the following three lines of code in the project archive function:

void ThisProject_Active()

{

zScreens = this.DynPictures();

zScreens.Open += new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
zScreens.Close += new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);
}

//Add the following two lines of code in the project inactive function:

void ThisProject_Inactive()

{
zScreens.Open -= new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
zScreens.Close -= new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);

//Final release and garbage collection of any API-Objects.
FreeObjects();

}

//Add two new event handlers:

void zScreens_Open(zenOn.IDynPicture obDynPicture)

{

foreach (string element in WPFElements)

{

if (obDynPicture.Elements().Item(element) != null)
{

obDynPicture.Elements().Item(element).set_WPFProperty("ELEMENT", "zenonVariableLink",
this.Variables().Item(0));

}
}
}

void zScreens_Close(zenOn.IDynPicture obDynPicture)

{

foreach (string element in WPFElements)

{

if (obDynPicture.Elements().Item(element) != null)

{

zenOn.IElement zWPFElement= obDynPicture.Elements().Item(element);
zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true);
zWPFElement = null;

}
}
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6.6.3 VSTA code (simplified)

If only one WPF element is used in a zenon screen, the following more streamlined code can be used as
an alternative. To do this, the names of the WPF element, and the screen in which the element is used,
must be entered. This code is then recommended if, for each project, only one of the pre-made WPF
elements is used.

VSTA CODE

zenOn.IDynPicture zScreen = zero;

string wpfElement

"WPF_Control"; //Name of the WPF element in the screen

string wpfPicture = "@Details_Overview_Online"; //Name of the zenon screen

//Add to the project active function:

void ThisProject_Active()

{

zScreen = this.DynPictures().Item(wpfPicture);
zScreen.Open += new zenOn.OpenEventHandler(zScreen_Open);

zScreen.Close += new zenOn.CloseEventHandler(zScreen_Close);

}

//Add to the project inactive function:

void ThisProject_Inactive()

{
zScreen.Open -= new zenOn.OpenEventHandler(zScreen_Open);
zScreen.Close -= new zenOn.CloseEventHandler(zScreen_Close);

//Final release and garbage collection of any API-Objects.
FreeObjects();

}

void zScreen_Open()

{
if (zScreen.Elements().Item(wpfElement) != null)

{

zScreen.Elements().Item(wpfElement).set_WPFProperty("ELEMENT", "zenonVariableLink",
this.Variables().Item(9));

}
}
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void zScreen_Close()

{
if (zScreen.Elements().Item(wpfElement) != null)

{
zenOn.IElement zWPFElement = zScreen.Elements().Item(wpfElement);

zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true);
zWPFElement = null;

}
}

6.7 Examples: Integration of WPF in zenon

You can see how XAML files are created and integrated as WPF elements in zenon from the following
examples:

» Integrate button as WPF XAML in zenon (on page 115)
» Integrate bar graph as WPF XAML in zenon (on page 111)

» Integrate DataGrid Control in zenon (on page 121)

6.7.1 Integrate bar graph as WPF XAML in zenon

Example structure:
» Creating a bar graph (on page 16) in Adobe lllustrator and converting it to WPF
» Integrate into zenon
» Linking with variables
» Adapting the bar graph WPF element

CREATE BAR GRAPH

The first step is to generate a bar graph as described in the Workflow with Adobe lllustrator (on page 16)
chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics
folder.

INTEGRATE BAR GRAPH

Note: A zenon project with the following content is used for the following description:
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» Anempty screen as a start screen
» Four variables from the internal driver for
» Scale0
» Scale central
» Scale high
» Current value

» A variable from the mathematics driver for displaying the current value (255)

To integrate the bar graph:
1. open the empty screen
place a WPF element (on page 49) in the screen

select XAML file in the properties window

oW

Select the desired XAML file (for example bar graph_vertical.xaml) and close the dialog

ADJUST BAR GRAPH

Before configuration, the scale of the XAML file is adapted if necessary:

counting Value

0=

To do this:
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» Create a new mathematics variable that calculates the new value in relation to the scaling,
for example:

» Variable: 0-1000

P Mathematic variable {value created in xaml file}*Variable/1000

Properties: Variable: calculation - Project: DOKU v 0 X

(53|

4

i
»

|
3

;
§

E

]
i

§

:
:
g
:

g

o

Value calculation

Calculaton active < no variable linked >

Decimals 0
Formula 350%X01/100
Hysteresis

[

[

Value adjustrment linear

[

Value adjustment non-linear L=

[

Value range PLC

ﬁ'Properties: Variable: calculation - Project: DOKU E Pmﬁeﬂ helg

The XAML file is then configured.

CONFIGURE BAR GRAPH
1. Click on the WPF element and select the Configuration property

2. The configuration dialog shows a preview of the selected XAML file.
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3.

4

Select the minimum value, the average value and the maximum value and link each of these to
the corresponding variable in the Content property

e ==
WPF clement |
Wor dement L= ]
Ay
vailable elements [—]
= COPA_DATA -
g
min
mid
- max
— shider
Action nk
T
Name Linkage Type of Ink | WPF info 4] Linked | =
| ActualHeight <nothing linked> | 529307402592... O |
ActualWidth <nothing linked> 52 [m]
AllowDrop <nothing linked>  False O
| BorderThickness <nothing linked> 00,00 [m]
ClipToBounds <nothing linked>  False [m]
{ Content Varisble 128 (]
| ContentStringFormat <nothing linked> O
| ContextMenuService.HasDro... <nothing linked>  False a
ContexstMenuService.Horizon,.. <nething linked> 0 [m]
ContextMenuServicelsEnabled <nothing linked>  True [m]
| ContextMenuService.Placem... <nothing linked> MousePoint [m]
| ContextMenuService. Placem... <nothing linked>  Empty a
ContextMenuService.ShowD... <nothing linked> | False [m]
| ContextMenuService.Vertical... <nothing linked> 0 [m]
Natalnntet ncthing linked n s

Select the Slider and link the Value property to the mathematics variables (in our example:

calculation)

Configuration =]
WPF clement |
o denent o ]
Ay
walable elements [—]
=I-COPA_DATA -
Sow
min
mid
- max
- slider
Action bnk
Propertes Events | Tonsfometons |
Name Linkags 4] Type of ink | WPF info Linke =
7| i | T Fieer
| FlowDirection <nothing linked> | LeftToRight O [F
Focusable <nothing linked> | True O
Fontsize <nothing linked= 12 ]
| FontStretch <nothing linked> Mormal m]
| FontStyle <nothing linked> | Mormal (]
FontWeight <nothing linked> | Mormal (]
| ForceCursor <nothing linked> = False m]
| Grid.Column <nothing linked> | 0 (]
Grid.ColumnSpan <nothing linked> | 1 (]
Grid Row <nothing linked= 0 ]
| Grid.RowSpan <nothing linked> 1 m]
HasAnimatedProperties <nothing linked> = False m]
; Maths Varisble . def. =)
HinrznntalAlinnment <nnthinn linked> | Rinkt B
« i ] »
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5. Check the project planning in Runtime:

counting Value _

6.7.2 Integrate button as WPF XAML in zenon

Example structure:

Creating a button (on page 12) in Microsoft Expression Blend
Integrate into zenon

Link to a variable and a function

adjust the button to the size of the element

v v v Vv Vv

Create button

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression
Blend (on page 12) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the
Files/Graphics folder.

INTEGRATE BUTTON

Note: A zenon project with the following content is used for the following description:
» Anempty screen as a start screen

» aninternal variable int of type Int

115 | 129



»

A Write/modify set value Function_0 function with:
» Direct to hardware option activated

» The target values should be configured with the value 45.

To integrate the button:

1.

A

open the empty screen

place a WPF element (on page 49) in the screen

select XAML file in the properties window

select the XAML file (e. g. MyButton.xaml and close the dialog

select the Configuration property

CONFIGURE THE BUTTON

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file
are listed in the tree:

Configuration
WPF element
WPF glement |—ICK
Avi Pr
vailable elements eview —I|
LayoutRoot -
= MyViewBox [
MyButton tie |
Action nk
Properties  Events | Transformations
Linked | Name Linkage A Type of ink | WPF info
O  ActualHeight <nething lin... 50
O ActualWidth <nething lin... 50
[m] AllowDrop <nothing lin...  False
[0  BorderThickness <nothing lin.. 1111
(] ClickMode <nething lin... Release
[m] ClipToBounds <nothing lin... False
(m] Command <nothing lin...
m] CommandParameter <nething lin...
O CommandTarget <nothing lin...
[ L0 Content int Voriable _Button |
O ContentStringFormat <nothing lin...
O ContextMenuService. HasDrop... <nething lin... | False
O  ContetMenuService Horizont... <nething lin... 0
(m] ContetMenuServicelsEnabled <nothing lin... True
[0 ContedhlenuSenics Placsmeant \_¢nothinn lin_ MoussBoint
1. select the WPF button, which is in LayoutRoot->MyViewBox->MyButton

oW

Look in the Properties EntryContent tab; this contains the button's text
Click the Link type column

Select Variable from the drop down list
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5.
6.
7.

EVENTS

Click in the Link column

the variable selection dialog is opened

select the int variable to link this variable with the Content property

To also assign events:

1.

O o N v AW

11.

select the tab Events

Button

iprl:-perlies Events | Transformations | User authari

ion/Interlocking

WPF event

Click
ContextMenuClosing
ContextMenuOpening
DataContextChanged
DragEnter

DraglLeave

DragQOver

Drop
FocusableChanged
GiveFeedback

Linked function

Function 0

Configuration ==
WPF element
Available elements Preview Cancel
=I- LayoutRoot
=I-MyViewBox L i ]

look for the 'Click' entry, this event is triggered by the WPF element, as soon as the button is

clicked

Click in the Link type column

Select Function from the drop down list

Click in the Link column

the function selection dialog is opened

select Function_0

Confirm the changes with OK
Insert a numerical value element into the screen
Link this numerical value element to the int variables too.

Compile the Runtime files and start Runtime.
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The WPF element is displayed in Runtime, the button text is 0. As soon as you click on the button, the
click event is triggered and the set value function is carried out. The value 45 is sent directly to the
hardware and both numerical value and button display the value 45 .

45 e

Define a set value of 30 via the numerical value element; this value is then also assumed by the WPF

element.

AUTHORIZATION

Similar to a numerical value, a WPF element can be locked according to authorizations (lock symbol)
or switched to be operable. Set the user authorization level to 7 for the WPF element and create a user
called Test with authorization level 1. In addition, set up the functions Login with dialog and Logout .

You link these two functions with 2 new text buttons on the screen.

In the WPF element configuration dialog, select the MyButton WPF button and select the Properties:

Konfiguration @
WPF-Element
WPF-Element Ll
jorhandene Elemente Vorsch,
Varhandene Vorschau —E"l
LayoutRoot
= MyViewBox Hife |
MyButton
Alcbonsverknupfungen
Sgenschaften Ereignisse | Transformationen
Name Veskruipfung L] Verknupfungsart | WPF-info Verknipft
InputMethod.lsinputhethodE... «<nichts verknupft>  False O
InputMethed lslnputMethods... <nichts verkniipft>  False O
InputMethod. PreferredimeCo... <nichts verkniipft> DoMotCare o =
InputMethod.PreferredimeSen.. <nichts verkndpft> DoMotCare m]
InputMethod. PreferredlmeState «nichts verkndpft>  DoMotCare O
IsArrangeValid <nichts verkndpft>  True ]
IsCancel <nichts verknipft>  False ]
IsDefault <nichts verknipft> False O
IsDefaulted <nichts verknipft> = False O
<nichts verknipft>  False O
<nichts verknapft>  True O
<nichts verknapft>  True ]
False [

llnnudtdethodFnahled <nichts verkniinft>
|
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1. Select the IsEnabled element

2. Click in the Link type column
3. Select Authorizations/interlocking from the drop down list
4. Click in the Link column
5. Inthe drop-down list, select the Authorized option
Configuration @
Link authorizationfinterlocking |
Linked status
=

Mot interlocked

Interlocked
Can be operated
Cannot be operated

6. Close the dialog with OK

Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After
Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be

operated. If you now log in as the user Test, the button is activated and can be operated. The button is
locked again as soon as you log out.

.El

n [ |

TRANSFORMATION

The XAML files must still be adapted to use transformations:
1. switch to the Expression Blend program

2. select MyButton, so that the properties of the element are visible in the events window

Apply relative transform

3. Under Transform at RenderTransform select the Apply relative transform option
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As a result of this, a block is inserted into the XAML file, which save the transformation settings

in runtime.

<Button.RenderTransform:
<TransformGroup>
<ScaleTransform ScaleX="1" ScaleY="1"/>
<SkewTransform AnglexX="@" Anglev="8"/>
<RotateTransform Angle="a"/>
<TranslateTransform X="8" ¥Y="8"/>
</TransformGroup>
</Button.RenderTransform:

Save the file and replace the old version in zenon with this new file.

Open the WPF element configuration dialog again:
a) select the MyButton button

b) select the Transformations tab

|Prbperlies Events | Transformations | User autharization/Interocking

WPF transformation Linked variable

RotateTransform. Angle nt
RotateTransform.CenterX

RotateTransform.CenterY

ScaleTransform, Center)

ScaleTransform. CenterY

ScaleTransform. ScaleX

ScaleTransform, Scale

SkewTransform. AngleX

SkewTransform, AngleY

SkewTransform. Center)

m

Configuration Ex
WPF element
Available elements Preview Cancel
=I- LayoutRoot
=N Hi
] M.v\hemﬂox - elp
-

C) select the element RotateTransform.Angle

d) Click in the Link type column

e) Select Transformations from the drop down list
f)  Click in the Link column

g) the variable selection dialog is opened

h) select the int variable to link this variable with the RotateTransform.Angle property
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Compile the Runtime files and start Runtime. Log in as the Test user and click on the button. The button
has the value 45 and the WPF element rotates by 45°.

?5\ 45

‘ Login 1 ‘ Logout 1

6.7.3 Integrate DataGrid Control in zenon

To create DataGrid control for zenon, you need:

»  Visual Studio (Visual Studio 2015 in this example)

CREATE WPF USER CONTROL

1. in Visual Studio, create a new Solution and a WPF User Control Library project in NET
Framework version 4 or higher therein.

Info: If the corresponding project template does not appear in the list of available templates,
this can be added by means of the search (field at the top right of the dialog).
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NET Framework 4.5 = Sort by: Default i [I= User Control

g WPF User Control Library Visual C# Type: Visual C#
4 Templates Wind Presentation F

dati

VB -
4 Visual G LY WPF User Control Library Visual Basic control library
af

© Windows
Web
b Office/SharePoint
Android
Cloud
Extensibility
b i0S
LightSwitch
Mobile Apps
Reporting
Sitverlight
Test
WCF
Workflow
b Visual Basic
b Visual C++
b Visual F#
SQL Server
b lawaSerint

P Online

DataGridControlLibrary

DataGridControlLibrary [w] Create directory for selution
"] Add to source control

In our example, the project is given the name DataGridControlLibrary.
2. Create a new data connection in the Server Explorer.

In our example, the database Northwind is used, which is provided by Microsoft as an example
database that can be downloaded for free.

Te set up the database connection:

a) Right-click on Data Connections.

O

) Select Add connection....

) Select Microsoft SOL Server (SQLClient) as Data source.

o 0O

) Select the corresponding server and database name.
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After adding the connection, the Server Explorer window should look a little like this:

Server Explorer

Fi

A A

v v v v w7

¢ |lwEi ok
4 gW Data Connections
4 E dbserverizenon_2012.northwind.dbo

Tables

ER Categories

R Contacts

FR CustomerCustomerDemo
BB CustomerDemographics
FR Customers

EH Employees

EH EmployeeTerritories
R Order Details

R Orders

ER Products

B Region

EH Shippers

B Suppliers

R Territories

Views

Stored Procedures
Functions

Synocnyms

Types

Assemblies

A new DataSet is created in the next step.

CREATING A DATASET

1. Right-clic

A A

window.

k on the project

Select Add — New Item... in the context menu

Create a new DataSet with the name DataSet].

Double click on the DataSet in order to open it in the Designer.

Drag the tables that you need (Customers and Orders in this example) to the DataSet design

Server Explorer
¢ "'zl B>
4 W Data Connections

Pl Tables
ER Categories
R Contacts

FR Customers
EH Employees

R Orders
ER Products
B Region
B Shippers
B Suppliers
R Territories
I Views

vV T T VW VTV T T T T T

PR AR ARl Source Control Explorer

c
| ILEI

4 E dbserver\zenon_2012.northwind.dbo

FR CustomerCustomerDemo
BB CustomerDemographics

EH EmployeeTerritories
R Order Details

% CustomeriD
CompanyMame
ContactName
ContactTitle
Address
City
Region
PostalCode
Country
Phone
Fax

& CustomersTableAdapter

shu Fill,GetData

5 Orders

The XAML file is modified in the next step.

? Orderd
CustomerlD
EmployeelD
OrderDate
RequiredDate
ShippedDate
ShipVia
Freight
ShipMName
ShipAddress
ShipCity
ShipRegion

>

v

& OrdersTableAdapter @
shu Fill,GetData ()
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CONFIGURATION OF THE XAML FILE

1. If not already there, add the Namespace as a reference to the class in the XAML file:

<UserControl x:Class="DataGridControllibrary.UserControll™
wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
wmlns:local="clr-namespace:DataGridControllibrary”|
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="3@8">

2. Define the resources and the DataGrid that is to be used in the WPF;
<UserControl.Resources>
<local:DataSet1 x:Key="DataSet1"/>

<CollectionViewSource x:Key="CustomersViewSource" Source="{Binding Path=Customers,
Source={StaticResource DataSet1}}"/>

</UserControl.Resources>
<Grid DataContext="{StaticResource CustomersViewSource}">

<DataGrid Name="DataGrid1" DisplayMemberPath="CompanyName"
ltemsSource="{Binding}" SelectedValuePath="CustomerlD" HorizontalAlignment="Stretch"
VerticalAlignment="Stretch"/>

</Grid>

3. Open the code-behind file (UserControl1.xaml.cs) and insert the following lines in the
constructor:

public UserControl1()
{
InitializeComponent();
DataSet1 ds = ((DataSet1)(FindResource("DataSet1")));

DataSet1TableAdapters.CustomersTableAdapter ta = new
DataSet1TableAdapters.CustomersTableAdapter();

ta.Fill(ds.Customers);

CollectionViewSource CustomersViewSource =
((CollectionViewSource)(this.FindResource("CustomersViewSource")));

CustomersViewSource.View.MoveCurrentToFirst();
}
In doing so, the following happens:
» The DataSet is obtained
» A new TableAdapter is created
» The DataSet is filled
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» The information is provided to the DataGrid control

The solution can now be built.

BUILD

Now build the solution. The corresponding DLL (DataGridControlLibrary.dll) is created in the output
folder of the project.

Now you have a DLL with the necessary functionality available.

However zenon can only display XAML files that cannot be linked to the code behind file, which is why
an additional XAML file is needed that references the DLL that has just been created.

To do this:
1. Create a further project, again as a WPF User Control Library
2. It was called DataGridControl in our example.

3. Insert a reference to the project that has just been built into this new project.

Reference Manager - DataGridControl

P Assemblies Searc
4 Projects MName Path Nam
DataGridControlLibrary Di\sources\DataGridControlLibrary'Dat [inee]

Solution
P Shared Projects
b COM

P Browse

4. The XAML files (UserControll.xaml) looks as follows:
<UserControl x:Class="DataGridControl.UserControll”
wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:local="clr-namespace:DataGridControl”
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="3@8">
<Grid>

</farid>
</UserControl>

5. Because all necessary content is contained in the DLL that has been created and no
code-behind is necessary, delete the following lines:

x:Class="DataGridControl.UserControl1"
xmIns:local="clr-namespace:DataGridControl"

6. Also delete (for the positioning) the following lines:
mc:lgnorable="d"
d:DesignHeight="300" d:DesignWidth="300"
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10.

11.

Delete the code-behind file (UserControll.xaml.cs) in this project.

Define what is to be displayed in the XAML file.

To do this, modify the XAML file as follows:

<UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmins:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmIns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
xmlns:d="http://schemas.microsoft.com/expression/blend/2008"

xmins:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridControlL
ibrary">

<Grid x:Name="Grid1">

<dataGridLibrary:UserControll Name="DataGridControl" HorizontalAlignment="Left"
VerticalAlignment="Top"/>

</Grid>
</UserControl>

The
linexmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridControlLi
brary" defines the namespace dataGridLibrary and stipulates that this should use the assembly
that has been created.

Assign a name for the grid.

Insert the control dataGridLibrary:UserControl1 from our library and give it a name, because
zenon can only modify objects that have a name.

Build the solution.

In the next step, how the DLL and XAML file are added to zenon is explained.

STEPS IN ZENON

1.
2.
3.

Open the zenon Editor
Go to File -> Graphics.

Select Add file... in the context menu

8, User administration
I SAP nterface

) G Add file...

1 History Editor profile »

sbal symbol i Help

126 | 129



Engineering in zenon ﬂ

Zenon

4. Select the XAML file at the save location (UserControll.xaml from the DataGridControl project)
and add this:

BB T BaAx T L0 &0
th
e

Status File name Type Size Preview

= Filter text Fiter... 7 |Fitter... W Filter text N

UserControll xaml xaml 0KB

5. Insert the DLL with the functionality for the XAML file.
To do this:
a) Select, in the context menu, File -> OtherAdd file....
b) Select the file DataGridControlLibrary.dll of the first project (DataGridControlLibrary).

Bt llanx Fl o 20

Status | File name Type # Size
Filter text W Fitter teat 7 |Fiter... ¥ |Fitter... ¥
DataGridControlLibrary.dll dll 36 KB

6. Create a zenon screen.
7. Add a WPF element and select the previously-incorporated XAML file.

You should now see the following in the zenon Editor:

T W swso - suwer oamaco.est x z
LD E DX R = T2 B
| | Status | Nome A Screenty
"Bad0 Standard : CustomeriD CompanyName Contact ContactTite
| ALK Alfreds Futterioste Maria Anders Ssles Representat « |
ANATR | Ans Trujibo Emparedados y helados | Ana Trujillc Owrer .’ £
ANTON Antonio Mereno Taqueria Antono Moreno | Owner
AROUT | Around the Hom Thomas Hardy | Sales Representat
BERGS Bergiunds snabbisp Cheisting Berghund | Order Administrat
BLAUS Biauer See Deliatessen Fanns Moos Sales Representat
BLONP Biondel pére et fils Frédénique Cteaux| Marketing Manag
B0uD Blido Comidas preparadas Martin Sommer | Owner
BONAP __|Bon spp’ Laurence Lebihan | Onner
BOTTM Bottom-Dollar Markets Elizabeth Lincoln | Accounting Mana
BSBEV B's Beverages Victoria Ashworth | Sales Representat
CACTU Cactus Comidas pars Bevar Patricio Simpson | Ssles Agent
CENTC Centro comercial Moctezuma Francisco Chang _| Marketing Mansg
CHOPS. cno«:m Chinese Yana Wara Owmer ¥
[, - 4
1 total / 1 filtered / 1 selected | o
] —— ,

8. Start zenon Runtime in order to also test the control there.
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Hint

DLLs that are part of a WPF element can also be replaced during ongoing
operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:

»

»

»

Close all zenon screens in which the WPF element is used.
Close all symbols that use a desired WPF element.

In Explorer, replace the DLL in the \wpfache folder of the Editor files.
You can find this folder in the SQL directory under
.\PROJECT-GUID\FILES\zenon\custom\wpfcache

As an alternative to replacement using Explorer, you can also replace the file in
the zenon Editor directly. To do this, carry out the following steps:

4

4

4

In the Visual Studio project settings, increase the file version of the DLL.
Create the new DLL.

Close all zenon screens in which the WPF element is used.

Close all symbols that use a desired WPF element.

In the zenon Editor, delete the DLL from the \Files\Other folder and add the
file with the higher version number.

6.8 Error handling

ENTRIES IN LOG FILES

N

Xaml file found in %s Warning  The name of the collective file and the name of the XAML
with different name, file contained therein do not correspond. To avoid internal

using default!

conflicts, the file with the name of the collective file and the
suffix .xaml is used.

no preview image Warning  The collective file does not contain a valid preview graphic

found in %s

(preview.png or [names of the XAML file].png). Thus no
preview can be displayed.

Xaml file in %s not Error The collective file does not contain an XAML file or several
found or not unique! files with the suffix .xaml. It cannot be used.

Could not remove old Warning  There is an assembly that is to be replaced with a newer
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assembly %s version, but cannot be deleted.
Could not copy new Error A new version is available for an assembly in the work folder,
assembly %s but it cannot be copied there. Possible reason: The old

example is still loaded, for example. The old version
continues to be used, the new version cannot be used,

file exception in %s Error A file error occurred when accessing a collective file.

Generic exception in %s  Error A general error occurred when accessing a collective file.
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